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The following configurable settings are available with this release:
	Access String Code
	Value and Default
	Description

	Alert.AgeGreaterThan
	Value=[None|Full], Default=[Full]
	Displays the "Age Greater Than" alert type when [Full]. 

	Alert.BothTechOnlyAndExternalReport
	Value=[None|Full], Default=[Full]
	Displays the "Both Tech Only and External Report" alert type when [Full]. 

	Alert.CDS_01_HighBP
	Value=[None|Full], Default=[Full]
	Displays the "High BP" alert type when [Full]. 

	Alert.CDS_02_HighCholesteral
	Value=[None|Full], Default=[Full]
	Displays the "High Cholesterol" alert type when [Full]. 

	Alert.CDS_03_PossibleReaction
	Value=[None|Full], Default=[Full]
	Displays the "Possible Reaction" alert type when [Full]. 

	Alert.CDS_04_TobaccoUser
	Value=[None|Full], Default=[Full]
	Displays the "Tobacco User" alert type when [Full]. 

	Alert.CDS_05_PneumoniaBooster
	Value=[None|Full], Default=[Full]
	Displays the "Pneumonia Booster" alert type when [Full]. 

	Alert.CDS_06_BreastCancerScreening
	Value=[None|Full], Default=[Full]
	Displays the "Breast Cancer Screening" alert type when [Full]. 

	Alert.ExpiredInsurance
	Value=[None|Full], Default=[Full]
	Displays the "Expired Insurance" alert type when [Full]. 

	Alert.HasAllergy
	Value=[None|Full], Default=[Full]
	Displays the "Has Allergy" alert type when [Full]. 

	Alert.HasProblem
	Value=[None|Full], Default=[Full]
	Displays the "Has Problem" alert type when [Full]. 

	Alert.InactiveCarrierAppliedToVisit
	Value=[None|Full], Default=[Full]
	Displays the "Inactive Carrier Applied to Visit" alert type when [Full]. 

	Alert.InactiveCCPhysicianOrAddress
	Value=[None|Full], Default=[Full]
	Displays the "Inactive CC Physician or Address" alert type when [Full]. 

	Alert.InactiveReferringOrAddress
	Value=[None|Full], Default=[Full]
	Displays the "Inactive Referring or Address" alert type when [Full]. 

	Alert.IndicationAndMedication
	Value=[None|Full], Default=[Full]
	Displays the "Indication and Medication" alert type when [Full]. 

	Alert.IndicationAndSevereContrastAllergy
	Value=[None|Full], Default=[Full]
	Displays the "Indication and Severe Contrast Allergy" alert type when [Full]. 

	Alert.LabOrderWithEmptyValue
	Value=[None|Full], Default=[Full]
	Displays the "Lab Order with Empty Value" alert type when [Full]. 

	Alert.MRI65PlusHeartDiseaseLipitorAndLDL100Plus
	Value=[None|Full], Default=[Full]
	Displays the "MRI65 Plus Heart Disease Lipitor and LDL100 Plus" alert type when [Full]. 

	Alert.OnMedication
	Value=[None|Full], Default=[Full]
	Displays the "On Medication" alert type when [Full]. 

	Alert.PatientBirthChanged
	Value=[None|Full], Default=[Full]
	Displays the "Patient Birth Changed" alert type when [Full]. 

	Alert.PatientDeceased
	Value=[None|Full], Default=[Full]
	Displays the "Patient Deceased" alert type when [Full]. 

	Alert.PatientDrugAllergyWhenArrivedOrStarted
	Value=[None|Full], Default=[Full]
	Displays the "Patient Drug Allergy when Arrived or Started" alert type when [Full]. 

	Alert.PatientFirstNameChanged
	Value=[None|Full], Default=[Full]
	Displays the "Patient First Name Changed" alert type when [Full]. 

	Alert.PatientFlagAlert
	Value=[None|Full], Default=[Full]
	Displays the "Patient Flag Alert" alert type when [Full]. 

	Alert.PatientLastNameChanged
	Value=[None|Full], Default=[Full]
	Displays the "Patient Last Name Changed" alert type when [Full]. 

	Alert.PatientMissingPhoneInfo
	Value=[None|Full], Default=[Full]
	Displays the "Patient Missing Phone Info" alert type when [Full]. 

	Alert.ProcedureXAndHighBP
	Value=[None|Full], Default=[Full]
	Displays the "Procedure X and High BP" alert type when [Full]. 

	Alert.ReportLockedOnTechAndViewEdit
	Value=[None|Full], Default=[None]
	Displays the "Report Locked on Tech and View/Edit" alert type when [Full]. Updated by #11265

	Clinical.AbortStudy
	Value=[None|Full], Default=[None]
	Displays the "Abort Study" button in the View/Edit screen when a study is in Exam Done, Exam Done Tech Only, Transcribed, Dictated and Report Drafted status. 

	Clinical.ACRSelect
	Value=[None|Full], Default=[None]
	Controls the ability to turn on ACR Select. 

	Clinical.AdditionalData
	Value=[None|Full], Default=[None]
	Controls access to the "Additional Data" grid. 

	Clinical.AddMRN
	Value=[None|Full], Default=[None]
	Controls the ability to add an MRN. 

	Clinical.AddOutsideRead
	Value=[None|Full], Default=[Full]
	Controls access to the "Add Outside Read" menu item from the Scheduling menu. 

	Clinical.AddPatient
	Value=[None|Full], Default=[Full]
	Controls access to the "Add Patient" menu item from the Scheduling menu. 

	Clinical.AdjustPaymentDate
	Value=[None|Full], Default=[None]
	Controls access to the "Adjust Payment Date" context menu from the Payments grid. 

	Clinical.AlertFramework
	Value=[None|Full], Default=[Full]
	Controls the ability to view alerts. This setting added for MU testing, to demonstrate that we can configure alerts not to fire for a specific user group. CAUTION: Recommended default is enabled [Full] for all users. 

	Clinical.AllowPeerReviewChanges
	Value=[None|Full], Default=[None]
	Controls the ability to modify peer reviews. 

	Clinical.AppointmentsBooked.AppointmentDragging
	Value=[None|Full], Default=[None]
	Controls the ability to change the scheduled modality and scheduled start time. 

	Clinical.AppointmentsBooked.HebrewDates
	Value=[None|Full], Default=[None]
	Controls access to the "Hebrew Dates" context menu from the Appointment Book header. Added in v3.2022.8.29 #28398

	Clinical.AppointmentsBooked
	Value=[None|Full], Default=[None]
	Controls access to the "Appointment Book" menu item from the Scheduling menu. 

	Clinical.AssignChair
	Value=[None|Full], Default=[Full]
	Controls the ability to assign chair settings from worklists. 

	Clinical.AssignEditor
	Value=[None|Full], Default=[None]
	Controls the ability to assign to Editor from worklists. 

	Clinical.AssignRadiologist
	Value=[None|Full], Default=[None]
	Controls access to the "Assign Radiologist" context menu. 

	Clinical.AssignRescheduledFlag
	Value=[None|Full], Default=[Full]
	Controls access to the "Rescheduled Flag » Set Follow up Rescheduled, and Rescheduled Flag » Clear Follow up Rescheduled" context menu. 

	Clinical.AssignToMe
	Value=[None|Full], Default=[None]
	Controls access to the "Assign to Me" context menu. Requires user to be Radiologist resource type. Added in v3.2022.5.9 #29513

	Clinical.AssignToPeerReview
	Value=[None|Full], Default=[None]
	Controls access to the "Send to Peer Review " context menu. 

	Clinical.AttachInboundDocuments.BreakLock
	Value=[None|Full], Default=[None]
	Controls the ability to Break Lock from the Attach Inbound Documents screen. 

	Clinical.AttachInboundDocuments.Editor.EditCategory
	Value=[None|Full], Default=[None]
	Controls the ability to assign/edit/remove "Category" values from the Inbound Document row editor dialog on the Attach Inbound Documents screen. Added in v3.2022.1.17 #29161

	Clinical.AttachInboundDocuments.Editor.EditPracticeSite
	Value=[None|Full], Default=[None]
	Controls the ability to reassign "Practice and Site" values from the Inbound Document row editor dialog on the Attach Inbound Documents screen. Added in v3.2022.1.17 #29161

	Clinical.AttachInboundDocuments.Editor
	Value=[None|Full], Default=[None]
	Controls access to the Inbound Document row editor dialog from the Attach Inbound Documents screen. Added in v3.2022.1.17 #29161

	Clinical.AttachInboundDocuments
	Value=[None|Full], Default=[None]
	Controls access to the "Attach Inbound Documents" screen. 

	Clinical.Attachments
	Value=[None|Full], Default=[Full]
	Controls access to the "Attachments" context menu from the Labwork, Reception, Patient Folder, Confirmation, Order To Schedule, andTechnologist worklists. Added in v3.2018.3.3 #26291

	Clinical.AUCReview
	Value=[None|Full], Default=[None]
	Controls access to the "AUC Review" screen. Added in v3.2021.3.15 #29104

	Clinical.AuditHistory.ShowReportPeerReviewed
	Value=[None|Full], Default=[None]
	Displays the report peer review date from the Audit History. 

	Clinical.AuditHistory
	Value=[None|Full], Default=[Full]
	Controls access to the "Audit History" context menu. 

	Clinical.Billing.CodingColumns
	Value=[ReadOnly|Full], Default=[None]
	Displays the billing confirmation coding columns from the Billing Codes grids. Renamed from Clinical.Billing.ShowCodingColumns. Added in v3.2018.5 #23424

	Clinical.BillingCodes.Modify
	Value=[None|Full], Default=[Full]
	Controls the ability to add, edit, or delete billing codes. 

	Clinical.BillingMethod
	Value=[None|Full], Default=[None]
	Controls access to the "Billing Method (self-pay)" feature. 

	Clinical.BurnCD
	Value=[None|Full], Default=[None]
	Controls access to the "Burn CD" menu item / context menu from Image Request, from Tech Perform Exam, and in the Patient Folder. 

	Clinical.BurnCDUncompressed
	Value=[None|Full], Default=[None]
	Controls the ability to select the "Uncompressed" compression option when burning a CD. Added in v2022.4.25 #29746

	Clinical.CacheStudy
	Value=[None|Disabled|Full], Default=[None]
	Controls access to the "Add To Cache" context menu to manually add a study to the cache. When [Disabled], context menu item is disabled. When [None], item is hidden. Added in v3.2018.5.6 #22725

	Clinical.CancelOrder
	Value=[None|Full], Default=[Full]
	Controls access to the "Cancel Order" context menu. When [Disabled], context menu item is disabled. When [None], item is hidden. Added in v3.2018.5.6 #22725

	Clinical.CarrierSearch.QuickSearchInactive
	Value=[None|Full], Default=[None]
	Controls the ability to include inactive carriers when performing a Carrier Search from the upper-right QuickSearch box. Added in v3.2021.2.1 #26900

	Clinical.CarrierSearch
	Value=[None|Full], Default=[None]
	Controls the ability to perform a Carrier Search including from the upper-right QuickSearch box. 

	Clinical.CDSMIntegrationDemo
	Value=[None|Full], Default=[None]
	Controls access to the "CDSM Integration Demo" context menu from the Patient Folder. Caution: Testing use only. Added in v3.2021.10.25 #30603

	Clinical.ChangeAssistantRadiologist
	Value=[None|Full], Default=[None]
	Controls access to the "Change Assistant Radiologist" context menu. 

	Clinical.ChangeDictateByRadiologist
	Value=[None|Full], Default=[None]
	Controls access to the "Change Dictate by Radiologist" context menu. 

	Clinical.ChangeExamDate
	Value=[None|Full], Default=[Full]
	Controls the ability to change the Performed Exam Date. 

	Clinical.ChangeStatusArrived
	Value=[None|Full], Default=[None]
	Displays the "Change Status To Arrived" context menu. 

	Clinical.ChangeStatusCanceledStudy
	Value=[None|Full], Default=[None]
	Displays the "Change Status To Canceled Study" context menu. 

	Clinical.ChangeStatusCancelTechRepReqd
	Value=[None|Full], Default=[None]
	Displays the "Change Status To Cancel Tech Rep Reqd" context menu. 

	Clinical.ChangeStatusDictated
	Value=[None|Full], Default=[None]
	Displays the "Change Status To Dictated" context menu. 

	Clinical.ChangeStatusExamDone
	Value=[None|Full], Default=[None]
	Displays the "Change Status To Exam Done" context menu. 

	Clinical.ChangeStatusOrderSigned
	Value=[None|Full], Default=[Full]
	Displays the "Change Status To Order Signed" context menu. 

	Clinical.ChangeStatusReportDrafted
	Value=[None|Full], Default=[None]
	Displays the "Change Status To Report Drafted" context menu. 

	Clinical.ChangeStatusStarted
	Value=[None|Full], Default=[None]
	Displays the "Change Status To Started" context menu. 

	Clinical.ChangeStatusToCheckingIn
	Value=[None|Full], Default=[Full]
	Displays the "Change Status To Checking In" context menu. 

	Clinical.ChangeStatusToScheduled
	Value=[None|Full], Default=[Full]
	Displays the "Change Status To Scheduled" context menu. 

	Clinical.ChangeSupervisingRadiologist
	Value=[None|Full], Default=[None]
	Controls access to the "Change Supervising Radiologist" context menu from the worklist. 

	Clinical.Confirmation
	Value=[None|Full], Default=[None]
	Controls access to the Confirmation screen. 

	Clinical.ConnectAnswers.Edit
	Value=[None|Full], Default=[None]
	Controls the ability to edit Connect Answers via the RIS. The Connect Answers are the patient provided answers to scheduling questions entered via the Patient Portal at the time of scheduling. 

	Clinical.ContrastTimer
	Value=[None|Full], Default=[None]
	Controls the ability to start and reset the Contrast Timer from the Technologist worklist. 

	Clinical.Coverage.Details.AlternateProcessingEngine
	Value=[None|Full], Default=[None]
	Controls the ability to turn on debug functionality to alter the coverage processing engine for the next insurance verification check. Note: This is debug functionality. (requires administrative access). 

	Clinical.CreateEditSendForDictation
	Value=[None|Full], Default=[None]
	Controls the ability to send a report for dictation from the Create/Edit Report screen. 

	Clinical.CreateReminder
	Value=[None|Full], Default=[None]
	Controls access to the "Create Reminder" context menu from the Patient Folder. 

	Clinical.CreateReportFromExamDone
	Value=[None|Full], Default=[None]
	Controls the ability to create or edit a report from Exam Done status. 

	Clinical.CreateTableInReport
	Value=[None|Full], Default=[Full]
	Controls the ability to create tables in Diagnostic Reports. 

	Clinical.CreateTechnicalRepeat
	Value=[None|Full], Default=[Full]
	Controls access to the "Technical Repeat" context menu. When [Disabled], context menu item is disabled. When [None], item is hidden. Added in v3.2018.5.6 #22725

	Clinical.CreateUnknownCarrier
	Value=[None|Full], Default=[Full]
	Controls the ability to create an Unknown Carrier. 

	Clinical.CreateUnknownReferring
	Value=[None|Full], Default=[None]
	Controls the ability to create an Unknown Referring Physician. 

	Clinical.CTRM
	Value=[None|Full], Default=[None]
	Controls access to the "CTRM" context menu from the Critical Results worklists. 

	Clinical.CTRMNotification
	Value=[None|Full], Default=[None]
	Controls access to the "CTRM Notifications" context menu When [Full], context menu item is enabled, otherwise item is hidden. Added in v3.2018.5.6 #22725

	Clinical.DataField.AmountToCollectNotes
	Value=[None|Full], Default=[None]
	Controls the ability to change previous Amount to Collect Notes from the Override Eligibility Status, Amount to Collect Details, and Patient Financial Responsibility Overide screens. Requires PatientFinancialResponsibilityOverride. Added in v3.2018.5.0.4 #22407

	Clinical.DataField.BillingDetail.Notes
	Value=[None|Full], Default=[None]
	Controls the ability to change previous Billing Notes. 

	Clinical.DataField.Order.SchedulerNotes
	Value=[None|Full], Default=[None]
	Controls the ability to change previous Scheduling Notes. 

	Clinical.DataField.OrderNotes
	Value=[None|Full], Default=[None]
	Controls the ability to change previous Order Notes. 

	Clinical.DataField.Patient.Notes
	Value=[None|Full], Default=[None]
	Controls the ability to change previous Patient Notes. 

	Clinical.DataField.Study.RadNotes
	Value=[None|Full], Default=[None]
	Controls the ability to change previous Radiologist Notes. 

	Clinical.DataField.Visit.BillToNotes
	Value=[None|Full], Default=[None]
	Controls the ability to change previous BILL TO Notes. 

	Clinical.DataField.Visit.IVTNotes
	Value=[None|Full], Default=[None]
	Controls the ability to change previous Insurance Verification Notes. 

	Clinical.DDECancelJobAction
	Value=[None|Full], Default=[Full]
	Controls access to the "Cancel Job Action" context menu from the Document Distribution Engine. 

	Clinical.DDEEditJobAction
	Value=[None|Full], Default=[Full]
	Controls access to the "Edit Job Action" context menu from the Document Distribution Engine. 

	Clinical.DDEMammoLetterSubmit 
	Value=[None|Full], Default=[Full]
	Controls access to the "Mammo Letter Submit" context menu from the Document Distribution Engine. 

	Clinical.DDENewJobAction
	Value=[None|Full], Default=[Full]
	Controls access to the "New Job Action" context menu from the Document Distribution Engine. 

	Clinical.DDEPauseJobAction
	Value=[None|Full], Default=[Full]
	Controls access to the "Pause Job Action" context menu from the Document Distribution Engine. 

	Clinical.DDEPreviewJobAction
	Value=[None|Full], Default=[Full]
	Controls access to the "Document Distribution Preview" context menu. When [Disabled], context menu item is disabled. When [None], item is hidden. Added in v3.2018.5.6 #22725

	Clinical.DDERetryJobAction
	Value=[None|Full], Default=[Full]
	Controls access to the "Retry Job Action" context menu from the Document Distribution Engine. 

	Clinical.DDHistoryByStudy
	Value=[None|Full], Default=[Full]
	Controls access to the "Distribution History" context menu. When [Disabled] or [None], context menu item is hidden. Added in v3.2018.5.6 #22725

	Clinical.DeleteDictationAndResetStatus.ExternalReportVerified
	Value=[None|Full], Default=[None]
	Controls the ability to revert a verified external report back to Exam Done status so it can be either re-verified or changed to a non-external report. 

	Clinical.DeleteDictationReportResetStatus
	Value=[None|Full], Default=[None]
	Controls access to the "Delete Dictation Report Reset Status" context menu. 

	Clinical.DiagnoseExternal
	Value=[None|Full], Default=[None]
	Controls the ability to open an external diagnose application. 

	Clinical.DictationControl
	Value=[None|Full], Default=[None]
	Controls the ability to use the dictation control. 

	Clinical.DigitalForms.AllowEditPostSignature
	Value=[None|Full], Default=[None]
	Controls the ability to edit digital forms after report is signed. 

	Clinical.DigitalForms.FormSelection
	Value=[None|Full], Default=[None]
	Controls the ability to select the digital form displayed when multiple studies use an identical digital form. Added in v3.2018.5.6 #28187

	Clinical.DirectMessage.Archive
	Value=[None|Full], Default=[Full]
	Controls access to the "Archive" context menu. 

	Clinical.DirectMessage.MarkAsRead
	Value=[None|Full], Default=[Full]
	Controls access to the "Mark As Read" context menu. 

	Clinical.DirectMessage.MarkAsUnread
	Value=[None|Full], Default=[Full]
	Controls access to the "Mark As Unread" context menu. 

	Clinical.DirectMessage.MoveToInbox
	Value=[None|Full], Default=[Full]
	Controls access to the "Move to Inbox" context menu. 

	Clinical.DirectMessage
	Value=[None|Full], Default=[Full]
	Controls access to the "Direct Message" menu item. 

	Clinical.EditAmountToCollectOrCurrentDOSPaymentAmount
	Value=[None|Full], Default=[None]
	Controls the ability to edit the "Amount to Collect" value in the Payment Details dialog when a Previous Balance does not exist. Added in v3.2021.5.24 #27641

	Clinical.EditClinicalTask
	Value=[None|Full], Default=[None]
	Controls the ability to add or edit tasks. Added in v3.2018.2

	Clinical.EditDiagnosticReport
	Value=[None|Full], Default=[None]
	Controls access to the "Edit Diagnostic Report" screen. 

	Clinical.EditExternalMRN
	Value=[None|Full], Default=[None]
	Controls the ability to edit an External MRN. 

	Clinical.EditImageRequest
	Value=[None|Full], Default=[None]
	Controls the ability to edit an Image Request from the Image Request worklist. 

	Clinical.EditMRN
	Value=[None|Full], Default=[None]
	Controls the ability to edit an MRN. 

	Clinical.EditOrder
	Value=[None|Full], Default=[None]
	Controls access to the "Edit Order" screen. 

	Clinical.EditPatient
	Value=[None|Full], Default=[None]
	Controls access to the "Edit Patient" screen. 

	Clinical.EditPatientFlags
	Value=[None|Full], Default=[None]
	Controls the ability to assign patient flags. 

	Clinical.EditPatientFlagsNotes
	Value=[None|Full], Default=[None]
	Controls the ability to add Notes to patient flags. 

	Clinical.EditPreApprovedPaymentAmount
	Value=[None|Full], Default=[None]
	Controls the ability to edit the "PreApproved payment amount" value in the Payment Details dialog when AllowImaginePreApprovedPayment is enabled. Added in v3.2021.5.24 #27641

	Clinical.EditReminder
	Value=[None|Full], Default=[None]
	Controls access to the "Edit Reminder" context menu from the Patient Folder. 

	Clinical.EditSchedule
	Value=[None|Full], Default=[None]
	Controls the ability to Edit Schedule. 

	Clinical.ExamSearch
	Value=[None|Full], Default=[Full]
	Controls the ability to perform an Exam Search from the upper-right corner of the application window. 

	Clinical.ExportIsraelMinistryOfHealth
	Value=[None|Full], Default=[None]
	Controls access to the "Export XML" menu item for the Israeli Ministry of Health. 

	Clinical.ExternalSearch
	Value=[None|Full], Default=[None]
	Controls the ability to perform an External Patient search from the upper-right corner of the application window. 

	Clinical.FindingFollowUp
	Value=[None|Full], Default=[Full]
	Controls access to the "Finding Followup" button and context menu. When [Disabled], context menu item is disabled. When [None], item is hidden. Added in v3.2018.5.6 #22725

	Clinical.FollowUp
	Value=[None|Full], Default=[Full]
	Controls access to the "Mammo Follow Up" screen. 

	Clinical.ForcePACSCorrection
	Value=[None|Full], Default=[Full]
	Displays the "Force PACS Correction flag" context menu. 

	Clinical.FormsAndLabels.AllowSaveAsAttachment
	Value=[None|Full], Default=[None]
	Controls the ability to save a form or label as an attachment. 

	Clinical.GoogleSearchAction
	Value=[None|Full], Default=[None]
	Controls the ability to perform a Google search from the upper-right corner of the application window. 

	Clinical.ImportCD
	Value=[None|Full], Default=[None]
	Controls access to the "Import CD" feature where full access allows users to import DICOM CDs, and read-only access allows users to view CD content via the Import CD feature but does not allow users to perform imports. 

	Clinical.ImportStudies.AcrossEMRs
	Value=[None|Full], Default=[None]
	Controls the ability to import studies into an order from a different EMR. 

	Clinical.ImportStudies
	Value=[None|Full], Default=[None]
	Controls access to the "for importing studies into an order" context menu. 

	Clinical.IndicationSearch
	Value=[None|Full], Default=[None]
	Controls the ability to perform an Indication Code Search including from the upper-right QuickSearch box. 

	Clinical.Infobar
	Value=[None|Full], Default=[None]
	Controls access to the InfoBar at the top of various screens. Added in v3.2018.3

	Clinical.InfoButton
	Value=[None|Full], Default=[Full]
	Controls access to the "View Medline Plus Info." button and context menu accessible from the MU tab grids for Medications, Medical History, or Lab Results. 

	Clinical.Insurance.AdditionalInjuryDetails
	Value=[None|Full], Default=[None]
	Displays the Additional Injury Detail fields (for Canadian billing). Full access shows the fields, while any other level of access will hide them. 

	Clinical.Insurance.Override
	Value=[None|Full], Default=[None]
	Controls the ability to override eligibility status on the Override Eligibility screen (right-click on shield). Added in v3.2018.5.0.4 #22407

	Clinical.Insurance.Reverify
	Value=[None|Full], Default=[None]
	Controls access to the "Reverify" button from the Manage Insurance groupbox. 

	Clinical.IVT.PreCertDeniedFinal
	Value=[None|Full], Default=[None]
	Controls the ability to select the "Denied (Final)" PreCert Status. Added in v3.2018.5.2

	Clinical.IVT
	Value=[None|Full], Default=[None]
	Controls access to the "IVT" screen. 

	Clinical.Labwork.AddEdit
	Value=[None|Full], Default=[None]
	Controls the ability to add or edit labwork. 

	Clinical.Labwork.Request
	Value=[None|Full], Default=[None]
	Controls the ability to request labwork (requires Clinical.Labwork.AddEdit). 

	Clinical.Linkstudies
	Value=[None|Full], Default=[None]
	Controls access to the "Link Studies" dialog from the Reception and Technologist worklists, and from the Patient Folder. Added in v3.2018.5.4 #27068

	Clinical.LockManager.BreakLock
	Value=[None|Full], Default=[None]
	Controls the ability to break another user's lock or to only have the read only option. 

	Clinical.MacroEditing
	Value=[None|Full], Default=[None]
	Controls access to the Macro Editor. 

	Clinical.MacroEditingAdvanced
	Value=[None|Full], Default=[None]
	Controls access to the Macro Editing Advanced assignments from a separate tab in the Macro Editor. 

	Clinical.MammoFollowUp
	Value=[None|Full], Default=[Full]
	Controls access to the "Mammo Follow Up" context menu. 

	Clinical.ManuallyResolveMammoFollowUp
	Value=[None|Full], Default=[Full]
	Controls the ability to manually resolve a follow up from the BI-RADS 0 and 4/5 Follow up worklists. 

	Clinical.MarkForAddendum
	Value=[None|Full], Default=[None]
	Controls access to the "Request Addendum and Cancel Addendum Request items" context menu from worklists. 

	Clinical.MarkOrder
	Value=[None|Full], Default=[None]
	Controls access to the "Mark Order" screen. 

	Clinical.ModifyTimestamps
	Value=[TBD], Default=[ReadOnly]
	Controls the ability to change time stamps set by RIS e.g. Start Time. 

	Clinical.ModifyTimestampsOutsideRead
	Value=[TBD], Default=[ReadOnly]
	Controls the ability to change Exam Date for an outside read. 

	Clinical.NewCrop
	Value=[None|Full], Default=[None]
	Controls access to the "NewCrop" functionality. Newcrop features will not exist unless Full. 

	Clinical.NewOrder
	Value=[None|Full], Default=[None]
	Controls access to the "New Order" screen. 

	Clinical.NoTimeOfServicePaymentCheckbox
	Value=[None|Full], Default=[None]
	Controls access to the "No time of service payment" checkbox on the Payment Details screen. This action sets the Payment for Previous Balance to $0.00 and sets the Payment for Current DOS and Amount to Collect to the value for NominalChargeForPreApprovedPayment (e.g. $0.01) to allow for a PreApproved Payment. Added in v3.2021.5.24 #27641

	Clinical.OpenSameOrderMultipleTimesAtOnce
	Value=[None|Full], Default=[None]
	Controls the ability to open two screens for the same order at once e.g. View/Edit and IVT. 

	Clinical.OpenStudySuspendedByOtherUser
	Value=[None|Full], Default=[None]
	Controls the ability to open a study suspended by another user. 

	Clinical.OpinionLetter.Preview
	Value=[None|Full], Default=[Full]
	Controls access to the "Opinion Letter » Preview Opinion Letter" context menu from worklists. 

	Clinical.OpinionLetter.Print
	Value=[None|Full], Default=[Full]
	Controls access to the "Opinion Letter » Print Opinion Letter items" context menu from worklists. 

	Clinical.OpinionLetter.Send
	Value=[None|Full], Default=[Full]
	Controls access to the "Opinion Letter » Send Opinion Letter items" context menu from worklists. 

	Clinical.OpinionLetter
	Value=[None|Full], Default=[Full]
	Controls access to the "Opinion Letter" context menu from worklists. 

	Clinical.PACSCorrection
	Value=[None|Full], Default=[Full]
	Controls access to the "PACS Correction" screen from the Pending PACS Correction worklist. 

	Clinical.PacsRemoveCachedStudy
	Value=[None|Disabled|Full], Default=[Full]
	Controls access to the "Remove From Cache" context menu. Added in v3.2018.5.6 #22725

	Clinical.PacsViewImages
	Value=[None|Disabled|ReadOnly|Full], Default=[Full]
	Controls access to the "PACS View Images" context menu. Added in v3.2018.5.6 #22725

	Clinical.PatientEditEmail
	Value=[None|Full], Default=[None]
	Controls access to the "Edit Email" button on the Patient tab. Added in v3.2018.3

	Clinical.PatientEditPhone
	Value=[None|Full], Default=[None]
	Controls access to the "Edit Phone" button on the Patient tab. Added in v3.2018.3

	Clinical.PatientFolder.EditPatient
	Value=[None|Full], Default=[Full]
	Controls access to the "Edit Patient" screen from the Patient Folder. Added in v3.2018.3

	Clinical.PatientFolder.Walkin
	Value=[None|Full], Default=[None]
	Controls access to the "Walk-in" button from the Patient Search Results screen and the Patient Folder worklist. Added in v3.2018.3 #21532

	Clinical.PatientMergeAdmin
	Value=[None|Full], Default=[None]
	Controls the ability to complete or reject suggested patient merges. 

	Clinical.PatientMergeMixer
	Value=[None|Full], Default=[None]
	Controls access to the "Patient Merge" screen. 

	Clinical.PatientSearch.SearchOtherIssuers
	Value=[None|Full], Default=[None]
	Controls the ability to perform a Patient Search by Other Issuers of ID from the Patient Search Window. 

	Clinical.PatientSearch
	Value=[None|Full], Default=[Full]
	Controls the ability to perform a Patient Search, and controls access to the Patient Search window including from the upper-right QuickSearch box. 

	Clinical.PaymentDetails
	Value=[None|Full], Default=[None]
	Controls access to the "Payment Details" screen prior to launching ImaginePay when AllowImaginePreApprovedPayment is enabled. This will allow the user to collect a PreApproved Payment. To edit the default value for the PreApproved Payment, Clinical.EditPreApprovedPayment is also needed. Added in v3.2021.5.24 #27641

	Clinical.PaymentExplanation
	Value=[None|Full], Default=[None]
	Controls access to the "PreApproved Payment Explanation" button and dialog from the Payment Details and Scheduling Review screens. Added in v3.2021.6.7 #29943

	Clinical.PeerReview.ExpandStatistics
	Value=[None|Full], Default=[None]
	Displays the additional details via a drop down on the peer review stat counter. 

	Clinical.PeerReview.MarkAsCompleted
	Value=[None|Full], Default=[None]
	Controls the ability to mark a peer review as completed. 

	Clinical.PeerReview
	Value=[None|Full], Default=[None]
	Controls access to the "Peer Review" button and context menu. 

	Clinical.PeerReviewExcludeFromStats
	Value=[None|Full], Default=[None]
	Controls the ability to assign or edit cases for directed audits. 

	Clinical.PerformExam.Button.ContextMenu
	Value=[None|Full], Default=[Full]
	Controls access to the "Perform Exam" button and context menu. 

	Clinical.PerformExam.EnablePrimaryTechFieldOnComplete
	Value=[None|Full], Default=[Full]
	Controls the ability to edit "Primary tech" field. When [None], the field will be read-only after Exam Done status. Added in v3.2022.8.29 #32075

	Clinical.PerformExam.NoReport
	Value=[None|Full], Default=[None]
	Controls access to the "No Report" checkbox from the Perform Exam window. 

	Clinical.PerformExam.ReportExternal
	Value=[None|Full], Default=[None]
	Controls access to the "Report External" checkbox from the Perform Exam window. 

	Clinical.PerformExam
	Value=[None|Full], Default=[None]
	Controls access to the "Technologist" screen from the Perform Exam window. 

	Clinical.PersonMerge
	Value=[None|Full], Default=[None]
	Controls access to the "Person Merge" screen. 

	Clinical.PersonMergeAdmin
	Value=[None|Full], Default=[None]
	Controls the ability to complete or reject suggested person merges. 

	Clinical.PersonSearch
	Value=[None|Full], Default=[Full]
	Controls the ability to perform a Person Search and controls access to the Patient Search window including from the upper-right QuickSearch box. 

	Clinical.PIXQuery
	Value=[None|Full], Default=[None]
	Controls the ability to perform an Identifier query. 

	Clinical.PortalLauncher
	Value=[None|Full], Default=[None]
	Controls access to the "Portal Integration" context menu. 

	Clinical.PreviewPreliminaryReport
	Value=[None|Full], Default=[None]
	Controls the ability to preview reports that have not been signed. 

	Clinical.PreviewSuspendedReport
	Value=[None|Full], Default=[None]
	Controls the ability to preview reports that were suspended by another user. 

	Clinical.PreviewTerminatedReport
	Value=[None|Full], Default=[None]
	Controls the ability to preview reports that have been terminated, such as Void and Discontinued statuses. 

	Clinical.PrintForms
	Value=[None|Full], Default=[Full]
	Controls access to the "Print Forms" context menu. When [Disabled], context menu item is disabled. When [None], item is hidden. Added in v3.2018.5.6 #22725

	Clinical.ProtocolReview.ScheduleOverride
	Value=[None|Full], Default=[None]
	Controls the ability to Schedule even though protocol review is required. Added in v3.2018.3

	Clinical.ProtocolReview
	Value=[None|Full], Default=[None]
	Controls access to the "Protocol Review" context menu from the worklist. Added in v3.2018.3

	Clinical.QuickRadarMessage
	Value=[None|Full], Default=[None]
	Controls access to the "Quick RADAR Message feature" context menu. 

	Clinical.Rad.AssignToRadiologistDropDown
	Value=[None|Full], Default=[Full]
	Controls the ability to assign to a Radiologistusing the "Assign To" control from the Reporting screen. 

	Clinical.Rad.EditTemplatesAndMacros
	Value=[None|Full], Default=[None]
	Controls access to the "Edit Templates and Macros" menu item from the Radiologist menu. 

	Clinical.Rad.InteractivePanel
	Value=[None|Full], Default=[None]
	Controls access to the "Interactive Panel" menu item from the Radiologist menu. 

	Clinical.Rad.ReportOnAccessionNumber
	Value=[None|Full], Default=[None]
	Controls access to the "Report On Accession Number" context menu from the Radiologist menu. 

	Clinical.Rad.SaveVersion
	Value=[None|Full], Default=[None]
	Controls access to the "Save" button from the Reporting screen which will save current edits without closing. Added in v3.2022.8.29 #28709

	Clinical.Rad.SignForImmediateRelease
	Value=[None|Full], Default=[None]
	Controls access to the "Sign for Immediate Release" Sign button option. 

	Clinical.RADAR.RequestStatusUpdate
	Value=[None|Full], Default=[None]
	Controls access to the "the request RADAR distribution job status update" context menu. Added in v3.2018.2

	Clinical.RADARNudge.ConnectProviderPortalLink
	Value=[None|Full], Default=[None]
	Controls access to the "RADAR Nudge eRAD Connect Provider Portal" link option. 

	Clinical.RADARNudge.RISLink
	Value=[None|Full], Default=[None]
	Controls access to the "RADAR Nudge eRAD RIS" link option. 

	Clinical.RADARNudge
	Value=[None|Full], Default=[None]
	Controls the ability to use "the Nudge Message" feature (renamed from Clinical.RADARSecureMessage). Added in v3.2018.3

	Clinical.RADARSecureMessage
	Value=[None|Full], Default=[None]
	Controls the ability to use "the Nudge Message" feature. Note: Renamed to "Clinical.RADARNudge". Added in v3.2018.3 #20739

	Clinical.RADARSecurePIC
	Value=[None|Full], Default=[None]
	Controls access to the "RADAR SecurePIC Message" feature. 

	Clinical.ReadPreCertNotes
	Value=[None|Full], Default=[Full]
	Controls the ability to view read PreCert and Verification Notes on non-IVT screens. 

	Clinical.ReceptionBarcodeWorkflow.DesktopScanner
	Value=[None|Full], Default=[Full]
	Controls access to the "Scan ID" button from Identify Patient. 

	Clinical.ReceptionBarcodeWorkflow.MagneticStripe
	Value=[None|Full], Default=[None]
	Controls access to the "Read Magnetic Stripe" button from Identify Patient. 

	Clinical.ReceptionBarcodeWorkflow
	Value=[None|Full], Default=[None]
	Controls the ability to turn on "the 2D Barcode" workflow from Reception. 

	Clinical.Reconcile
	Value=[None|Full], Default=[Full]
	Controls access to the "Reconcile" menu item. 

	Clinical.Registration
	Value=[None|Full], Default=[None]
	Controls access to the "Registration" screen. 

	Clinical.ReleaseTentativelySignedReport
	Value=[None|Full], Default=[None]
	Controls access to the context menu to release or push an exam to Signed status. 

	Clinical.RemoveFollowupRequired
	Value=[None|Full], Default=[None]
	Controls access to the "Remove Follow Up Required Flag" context menu from worklists. 

	Clinical.RemoveFromPeerReviewWL
	Value=[None|Full], Default=[None]
	Controls access to the "Remove from Peer Review" context menu. 

	Clinical.RemoveMRN
	Value=[None|Full], Default=[None]
	Controls the ability to Remove MRN. 

	Clinical.RemovePendingBiopsyResult
	Value=[None|Full], Default=[None]
	Controls access to the "Remove Pending Biopsy Result Flag" context menu from worklists. 

	Clinical.RemoveSuspendedFlag
	Value=[None|Full], Default=[None]
	Controls access to the "Unsuspend" context menu from worklists. 

	Clinical.Report.Preview
	Value=[None|Full], Default=[Full]
	Controls access to the "Report » Preview Report" context menu. 

	Clinical.Report.Print
	Value=[None|Full], Default=[Full]
	Controls access to the "Report » Print Report" context menu. 

	Clinical.Report
	Value=[None|Full], Default=[Full]
	Controls access to the "Report" context menu. 

	Clinical.ReportEditor.AdvancedMenu
	Value=[None|Full], Default=[None]
	Controls access to the "Advanced Menu" menu item from the eRAD Report Editor. 

	Clinical.ReportHistory
	Value=[None|Full], Default=[None]
	Controls access to the "View Report History" context menu. 

	Clinical.ReportingPeerReviewQa
	Value=[None|Full], Default=[Full]
	Controls access to the "Peer Review" button and context menu. When [Disabled], button is disabled and menu item is hidden. When [None], both are hidden. Added in v3.2018.5.6 #22725

	Clinical.ReportingRadiologist
	Value=[None|Full], Default=[None]
	Controls the ability to open the Dictate and Sign Reports screens. 

	Clinical.ReportingTranscription
	Value=[None|Full], Default=[None]
	Controls access to the "Edit or Create/Edit Report" screen. 

	Clinical.RepostToBilling
	Value=[None|Full], Default=[None]
	Controls access to the "Billing Confirmation » Repostaction" context menu. 

	Clinical.RequestImageCopy
	Value=[None|Full], Default=[None]
	Controls access to the "Request Image Copy" context menu. 

	Clinical.Reschedule
	Value=[None|Full], Default=[None]
	Controls access to the "Reschedule" context menu. 

	Clinical.ResendDictationForRecognition
	Value=[None|Full], Default=[None]
	Controls access to the "Resend Dictation for Recognition" context menu. 

	Clinical.ResolveRadProblem 
	Value=[None|Full], Default=[Full]
	Controls access to the "Resolve Problem" context menu from worklists. 

	Clinical.RISAdminChangeStatus
	Value=[None|Full], Default=[None]
	Controls the ability to change the status of an exam that otherwise cannot be changed. (requires administrative access). 

	Clinical.ScanDocs.AllowEditScanTypes
	Value=[TBD], Default=[Disabled]
	Controls access to the "Scan Type" lookup table editor. 

	Clinical.ScanDocs.AllowExport
	Value=[None|Full], Default=[None]
	Controls the ability to export an image of a scanned document. 

	Clinical.ScanDocs.AllowImport
	Value=[None|Full], Default=[Full]
	Controls the ability to import a file as a scanned document (requires Scan New Docs). 

	Clinical.ScanDocs.AllowMarkAsReviewed
	Value=[None|Full], Default=[None]
	Controls the ability to modify the reviewed status of an attachment. 

	Clinical.ScanDocs.AllowModifyScanDocuments
	Value=[TBD], Default=[Disabled]
	Controls the ability to rotate existing scanned documents. 

	Clinical.ScanDocs.AllowRemoveImages
	Value=[TBD], Default=[Disabled]
	Controls the ability to delete existing scanned documents. 

	Clinical.ScanDocs.ImageRecognitionData.Submit
	Value=[None|Full], Default=[None]
	Controls access to the "Image Recognition Data" context menu from Attachment Viewer screens to submit recognition requests. Added in v3.2021.11.22 #30739

	Clinical.ScanDocs.ScanNewDocs
	Value=[TBD], Default=[Disabled]
	Controls the ability to add (scan, import) images of documents to patient and/or exam. 

	Clinical.Schedule.AllowManualSchedulingInClosed
	Value=[None|Full], Default=[None]
	Controls the ability to manually schedule appointments in closed (gray) Appointment Book time slots. 

	Clinical.Schedule.AllowManualSchedulingInHoliday
	Value=[None|Full], Default=[None]
	Controls the ability to manually schedule appointments in holiday (pink) appointment book time slots. 

	Clinical.Schedule.AllowManualSchedulingInOpen
	Value=[None|Full], Default=[Full]
	Controls the ability to manually schedule appointments in open (white) Appointment Book time slots. Added in v3.2018.3.3 #26791

	Clinical.Schedule.AllowManualSchedulingInRestricted
	Value=[None|Full], Default=[Full]
	Controls the ability to manually schedule appointments in restricted (yellow) appointment book time slots. 

	Clinical.Schedule.AllowManualSchedulingInUnavailable
	Value=[None|Full], Default=[Full]
	Controls the ability to manually schedule appointments in unavailable (blue) appointment book time slots. 

	Clinical.Schedule.AllowManualSchedulingInUndesirable
	Value=[None|Full], Default=[Full]
	Controls the ability to see time slots that create subsequent unusable gaps in the schedule. Added in v3.2021.9.27 #29683

	Clinical.Schedule.AllowOverbooking
	Value=[None|Full], Default=[None]
	Controls the ability to supress the Overbooking error from appearing on the GUI. 

	Clinical.Schedule.AllowResourceSchedulingOverride
	Value=[None|Full], Default=[None]
	Controls the ability to manually schedule in time slots with Resource Scheduling conflicts. Added in v3.2018.2

	Clinical.Schedule.AssignIcdCode
	Value=[None|Full], Default=[None]
	Controls the ability to assign ICD codes during scheduling, ordering, and registering. 

	Clinical.Schedule.AssignRadiologist
	Value=[None|Full], Default=[Full]
	Controls the ability to assign a Radiologist from the Schedule and Registration screens. 

	Clinical.Schedule.AutoCopyRoom
	Value=[None|Full], Default=[None]
	Controls access to the "auto-copy room for same modality type" feature when scheduling. Added in v3.2018.3.3 #26304

	Clinical.Schedule.BookX.AddOrder
	Value=[None|Full], Default=[None]
	Controls the ability to add a new order from the Schedule screen. 

	Clinical.Schedule.Calendar
	Value=[None|Full], Default=[None]
	Controls access to the Schedule Calendar. 

	Clinical.Schedule.HebrewDates
	Value=[None|Full], Default=[None]
	Controls access to the "Hebrew Dates" context menu from the Scheduling window. Added in v3.2022.8.29 #28397

	Clinical.Schedule.ManualBook.Duration
	Value=[None|Full], Default=[None]
	Controls the ability to modify Duration in the Procedure Picker. 

	Clinical.Schedule.ManualBook
	Value=[None|Full], Default=[Full]
	Controls the ability to modify Modality/Schedule times in the Procedure Picker. 

	Clinical.Schedule.NewAppointment
	Value=[None|Full], Default=[Full]
	Controls access to the "Appointment" button on the Schedule menu. Added in v3.2018.3

	Clinical.Schedule.ReminderRequest
	Value=[None|Full], Default=[None]
	Controls access to the "Reminder Request" button from the Schedule Review tab. 

	Clinical.Schedule.RescheduleLater
	Value=[None|Full], Default=[Full]
	Controls access to the "Schedule Later" button From the Reschedule Dialog, Cancel Study dialog, the Tech screen's Abort button, and from Schedule Order while rescheduling a study. When not full, then only cancellation is available. Added in v3.2018.3.3 #24397

	Clinical.Schedule.SaveAsOrder
	Value=[None|Full], Default=[Full]
	Controls access to the "Save As Order/Schedule Later" button from the Schedule/Reschedule screen, and from the Schedule Later button on the Reschedule Reason dialog. 

	Clinical.Schedule.ShowUndesirableTimeSlots
	Value=[None|Full], Default=[Full]
	Controls the ability to schedule time slots that create subsequent unusable gaps in the schedule. Added in v3.2021.9.27 #29683

	Clinical.Schedule.SplittingOrders
	Value=[None|Full], Default=[None]
	Controls the ability to break a study from one order and move it to a new or exsisting order. 

	Clinical.Schedule.TimeBetweenStudies
	Value=[None|Full], Default=[Full]
	Displays the "Min/Max" Search Options when scheduling. 

	Clinical.ScheduleFrom
	Value=[None|Full], Default=[None]
	Controls access to the "Schedule From" menu item that is used for scheduling a new exam based on the selected row in the worklist. 

	Clinical.ScheduleOrder
	Value=[None|Full], Default=[None]
	Controls access to the "Schedule Order" menu item. 

	Clinical.ScheduleSearch.IncludeUnavailable
	Value=[None|Full], Default=[Full]
	Controls visibility of the "Include sites without avalability" checkbox in Scheduling search results. Added in v3.2021.2.15 #26672

	Clinical.ScheduleSearch.SortByDistance
	Value=[None|Full], Default=[Full]
	Controls visibility of the "Sort by distance" controls in Scheduling search results for a User Group. When [Full] the sort radio buttons and distance filter dropdown are visible. Added in v3.2021.2.15 #26672

	Clinical.SecureMessage
	Value=[None|Full], Default=[Full]
	Controls access to the "SecureMessage" menu item. 

	Clinical.SendAppointmentSummary
	Value=[None|Full], Default=[None]
	Controls access to the "Send Appointment Summary" feature in the Scheduling Summary dialog, Patient Folder, and the Reception, Confirmation, and IVT worklists. Added in v3.2018.5.5 #24233

	Clinical.SendExamAccessInvitation
	Value=[None|Full], Default=[None]
	Controls access to the "Send exam access invitation" context menu from the Patient Folder for exams in Arrived status or later. Added in v3.2021.5.10 #28124

	Clinical.SetDeceasedFlag
	Value=[TBD], Default=[ReadOnly]
	Controls the ability to flag a patient as Deceased. 

	Clinical.SetFollowupRequired
	Value=[None|Full], Default=[None]
	Controls access to the "Set Follow Up Required Flagon worklists" context menu from worklists. 

	Clinical.SetMarkAsReadFlag
	Value=[None|Full], Default=[None]
	Controls access to the "Mark As Read or Unmark As Read" menu item. 

	Clinical.SetPendingBiopsyResult
	Value=[None|Full], Default=[None]
	Controls access to the "Set Pending Biopsy Result Flagon worklists" context menu from worklists. 

	Clinical.SetProblemFlag
	Value=[None|Full], Default=[None]
	Controls access to the "Assign To Problem Queue" context menu. 

	Clinical.SetQaFlag
	Value=[None|Full], Default=[None]
	Controls access to the "Assign To QA Queue" context menu. 

	Clinical.SetSequesterFlag
	Value=[None|Full], Default=[None]
	Controls the ability to flag an exam as Sequestered. 

	Clinical.SetStatFlag
	Value=[None|Full], Default=[None]
	Controls the ability to flag an exam as STAT. 

	Clinical.SetSuspendedFlag
	Value=[None|Full], Default=[None]
	Controls access to the "Suspend Study" context menu from worklists. 

	Clinical.ShowRVUs
	Value=[None|Full], Default=[None]
	Displays the "RVU" values on the Chair Selector report. Added in v3.2018.5.6 #21765

	Clinical.SiteSearch
	Value=[None|Full], Default=[None]
	Controls access to the "Site Search" feature. 

	Clinical.SuspendStudyFromOtherUser
	Value=[None|Full], Default=[None]
	Controls access to the "suspending a study from another user" context menu from worklists. 

	Clinical.Tech.AllowAddExam
	Value=[None|Full], Default=[None]
	Controls access to the "Add Exam to Current Order" button from the Perform Exam screen. 

	Clinical.Tech.ModifyTechNotesAfterCompletion
	Value=[None|Full], Default=[None]
	Controls the ability to change Tech Notes after the study has been completed. 

	Clinical.TemplateEditing
	Value=[None|Full], Default=[None]
	Controls the ability to edit "Template Browser" templates from the Radiology screen. 

	Clinical.TrainingImportTestReport
	Value=[None|Full], Default=[Full]
	Controls the ability to import test reports for training purposes. 

	Clinical.TrainingResetToReportDrafted
	Value=[None|Full], Default=[Full]
	Controls the ability to reset reports to Drafted for training purposes. 

	Clinical.UnsuspendStudyFromOtherUser
	Value=[None|Full], Default=[None]
	Controls access to the "unsuspending a study from another user" context menu from worklists. 

	Clinical.UpdatePreCertDetails
	Value=[None|Full], Default=[None]
	Controls the ability to edit "PreCert Details" column from worklists and billing code grids that have the existing PreCert Status column. Added in v3.2018.5.5 #25018

	Clinical.UtilizationManagement.InternalNotes
	Value=[None|Full], Default=[None]
	Controls access to the Utilization Review Internal Notes. 

	Clinical.UtilizationManagement.ScheduleOverride
	Value=[None|Full], Default=[None]
	Controls the ability to override Utilization Review and proceed to schedule. 

	Clinical.UtilizationManagement.UMBypass
	Value=[None|Full], Default=[None]
	Controls access to the "Bypass UM" checkbox. 

	Clinical.UtilizationManagement
	Value=[None|Full], Default=[None]
	Controls access to the "Utilization Review" context menu from worklists. 

	Clinical.VerifyExternalReport
	Value=[None|Full], Default=[None]
	Controls the ability to Verify External Report. 

	Clinical.VerifyReport
	Value=[None|Full], Default=[None]
	Controls access to the "Verify Report" button and context menu. 

	Clinical.ViewEdit
	Value=[TBD], Default=[ReadOnly]
	Controls access to the "View Edit" screen from the Patient folder. 

	Clinical.ViewEditCanChangeDiagIndications
	Value=[None|Full], Default=[None]
	Controls the ability to edit the indications defined by the Radiologist from View/Edit. 

	Clinical.ViewEditCanChangeProcedureWhenScheduled
	Value=[None|Full], Default=[Full]
	Controls the ability to modify the procedure and scanner fields from View/Edit before the exam has been completed and the View/Edit screen is mapped to the scheduled_modality_code instead of the performed_modality_code. Added in v3.2021.9.27 #30162

	Clinical.ViewEditCanChangeTechIndications
	Value=[None|Full], Default=[None]
	Controls the ability to edit the indications defined by the Technologist from View/Edit. 

	Clinical.ViewStudy.Button.ContextMenu
	Value=[None|Full], Default=[None]
	Controls access to the "View Study" button and context menu. Updated in v3.2022.8.29 #28711

	Clinical.ViewStudy
	Value=[None|Full], Default=[None]
	Controls the ability to open the View Study screen (dictate in read only mode). 

	Clinical.Visit.PatientFinancialResponsibilityOverride.Manual
	Value=[None|Full], Default=[None]
	Controls the ability to select and modify the different manual overrides for visit_cost, co_pay, deductible and co_insurance in the Patient Financial Responsibility Override screen. If a user has full access, they will also be given full access to select different Source Selections, regardless of the setting for the SourceSelection access string. Added in v3.2018.5.0.4 #22407

	Clinical.Visit.PatientFinancialResponsibilityOverride.SourceSelection
	Value=[None|Full], Default=[None]
	Controls the ability to select different sources for visit_cost, co_pay, deductible and co_insurance in the Patient Financial Responsibility Override screen. Added in v3.2018.5.0.4 #22407

	Clinical.Visit.PatientFinancialResponsibilityOverride
	Value=[None|Full], Default=[None]
	Controls the ability to override Patient financial responsibility, Estimated visit cost, and Eligibility status from the Amount to Collect Details screen. When set to FULL, the user will see the Override button on the Amount to Collect Details screen and will be able to launch and make edits to the Patient Financial Responsibility Override screen. Added in v3.2018.5.0.4 #22407

	Clinical.VoidPayment
	Value=[TBD], Default=[Disabled]
	Controls the ability to void payments. 

	Clinical.VoidStudy
	Value=[None|Full], Default=[None]
	Controls the ability to change a Signed study to Void from the View/Edit screen. 

	Clinical.Walkin.AutoCopyRoom
	Value=[None|Full], Default=[None]
	Controls access to the "auto-copy room for same modality type" feature when doing a walk-in. Added in v3.2018.3.3 #26304

	Clinical.Walkin
	Value=[None|Full], Default=[None]
	Controls access to the "Walk-in" menu item from the Front Desk menu. 

	Clinical.WalkinOrder
	Value=[None|Full], Default=[None]
	Controls access to the "Walk-in" context menu from the Orders To Schedule worklist and the Patient Folder worklist. Appears for items in Ordered status. Added in v3.2018.3.3 #25803

	Config.AIArbitrator
	Value=[None|Full], Default=[None]
	Controls access to the "configuration" screen for A.I. Arbitration. 

	Config.AllowEradReportingIntegration
	Value=[None|Full], Default=[None]
	Controls the ability to turn on the eRAD reporting workflow (requires administrative access). 

	Config.AllowExternalReportingIntegration
	Value=[None|Full], Default=[None]
	Controls the ability to turn on the External Reporting workflow (requires administrative access). 

	Config.AllowMModalReportingIntegration
	Value=[None|Full], Default=[Full]
	Controls the ability to turn on the M*Modal reporting workflow (requires administrative access). 

	Config.AllowPowerScribeReportingIntegration
	Value=[None|Full], Default=[None]
	Controls the ability to turn on the PowerScribe reporting workflow (requires administrative access). 

	Config.AppointmentBook.ModalityClosure.AllPractices
	Value=[None|Full], Default=[None]
	Controls access to the "Create Closure" context menu in the Appointment Book on an empty timeslot to create closures and restrictions in rooms across all practices. If not Full, the practice must be assigned to the user to create a closure or restriction in the modality. Added in v3.2018.5.5 #27269

	Config.AppointmentBook.ModalityClosure
	Value=[None|Full], Default=[None]
	Controls access to the "Create Closure" context menu in the Appointment Book on an empty timeslot to create closures and restrictions in rooms for their practices. Added in v3.2018.3.2 #25391

	Config.CDSJobManager
	Value=[None|Full], Default=[None]
	Controls access to the "CDS Job Manager" menu item from the Administration menu. 

	Config.Configure
	Value=[None|Full], Default=[None]
	Controls access to the "Configure" menu item from the Administration menu. 

	Config.CreateMessage
	Value=[None|Full], Default=[None]
	Controls the ability to create a new secure message for comunication between Patient Portal and RIS. 

	Config.DataSetVisualizer
	Value=[None|Full], Default=[None]
	Controls the ability to use the DataSet Visualizer for viewing content base datasets. 

	Config.DDWorklist
	Value=[None|Full], Default=[None]
	Controls access to the "Distribution WL" menu item from the Administration menu. 

	Config.DigitalFormsEditor
	Value=[None|Full], Default=[None]
	Controls access to the browser-based Digital Forms editor. 

	Config.LookupEditor.AbortedStudyReason
	Value=[None|Full], Default=[None]
	Controls access to the "Aborted Study Reason" lookup table editor. 

	Config.LookupEditor.AccessString.AllowedToChangeDefaults
	Value=[None|Full], Default=[None]
	Controls the ability to edit the default access level code on Access Strings. 

	Config.LookupEditor.AccessString.CustomAccessStrings
	Value=[None|Full], Default=[None]
	Controls the ability to add, edit, and delete custom Access Strings. 

	Config.LookupEditor.AccessString
	Value=[None|Full], Default=[None]
	Controls access to the "Access Strings" lookup table editor. 

	Config.LookupEditor.AdditionalResource
	Value=[None|Full], Default=[None]
	Controls access to the "Additional Resources" lookup table editor. 

	Config.LookupEditor.AddressDescription
	Value=[None|Full], Default=[None]
	Controls access to the "Address Description" lookup table editor. 

	Config.LookupEditor.Affiliation
	Value=[None|Full], Default=[None]
	Controls access to the "Affiliation" lookup table editor. 

	Config.LookupEditor.AICategory
	Value=[None|Full], Default=[None]
	Controls access to the "AICategory" lookup table editor. Added in v3.2021.3.1 #29218

	Config.LookupEditor.AlertConfiguration
	Value=[None|Full], Default=[None]
	Controls access to the "Alerts" lookup table editor. 

	Config.LookupEditor.Allergy
	Value=[None|Full], Default=[None]
	Controls access to the "Allergy" lookup table editor. 

	Config.LookupEditor.AllergyReaction
	Value=[None|Full], Default=[None]
	Controls access to the "Allergy Reaction" lookup table editor. 

	Config.LookupEditor.AllergySeverity
	Value=[None|Full], Default=[None]
	Controls access to the "Allergy Severity" lookup table editor. 

	Config.LookupEditor.ApplicationLanguage
	Value=[None|Full], Default=[None]
	Controls access to the "Application Language" lookup table editor that defines the RIS application UI language. 

	Config.lookupeditor.ApplyTranslation
	Value=[None|Full], Default=[None]
	Controls the ability to create translated text values for lookup tables. 

	Config.LookupEditor.AUCAdherence
	Value=[None|Full], Default=[None]
	Controls access to the "AUCAdherence" lookup table editor indicating AUC assessment outcome statuses. Added in v3.2018.5.2 #24206

	Config.LookupEditor.AUCHardship
	Value=[None|Full], Default=[None]
	Controls access to the "AUCHardship" lookup table editor indicating available AUC exemption reasons for assessing AUC. Added in v3.2018.5.2 #24206

	Config.LookupEditor.AUCMechanism
	Value=[None|Full], Default=[None]
	Controls access to the "AUCMechanism" lookup table editor indicating available mechanism types for assessing AUC. Added in v3.2018.5.2 #24206

	Config.LookupEditor.AUCPriorityClinicalArea
	Value=[None|Full], Default=[None]
	Controls access to the "AUC Priority Clinical Area" lookup table editor. Added in v3.2021.3.15 #29110

	Config.LookupEditor.AUCRules
	Value=[None|Full], Default=[None]
	Controls access to the "AUC Rules" lookup table editor for identifying items eligible for the AUC workflow. Renamed from Config.LookupEditor.CDSRules to better reflect its purpose. Added in v3.2018.5.2 #24206

	Config.LookupEditor.AUCStatus
	Value=[None|Full], Default=[None]
	Controls access to the "AUCStatus" lookup table editor indicating progress of the procedure or order within the AUC workflow. Added in v3.2018.5.2 #24206

	Config.LookupEditor.AuditHistory
	Value=[None|Full], Default=[None]
	Controls the ability to view configuration changes from the Audit Log. 

	Config.LookupEditor.Autotext
	Value=[None|Full], Default=[None]
	Controls access to the "Autotext" lookup table editor. 

	Config.LookupEditor.AvailabilityTemplate
	Value=[None|Full], Default=[None]
	Controls access to the "Availability Template" lookup table editor. 

	Config.LookupEditor.AvailityPayers
	Value=[None|Full], Default=[None]
	Controls access to the "Availity Payers" lookup table editor. 

	Config.LookupEditor.BATCollection
	Value=[None|Full], Default=[None]
	Controls access to the "BATCollection" lookup table editor. Added in v3.2022.6.20 #31786

	Config.LookupEditor.BillingCode
	Value=[None|Full], Default=[None]
	Controls access to the "Billing Code" lookup table editor. 

	Config.LookupEditor.BillingModalityType
	Value=[None|Full], Default=[None]
	Controls access to the "Billing Modality Type" lookup table editor used in KBI. 

	Config.LookupEditor.BillToType
	Value=[None|Full], Default=[None]
	Controls access to the "Bill To Type" lookup table editor. 

	Config.LookupEditor.Birad
	Value=[None|Full], Default=[None]
	Controls access to the "Birad" lookup table editor of BI-RADS codes and descriptions. 

	Config.LookupEditor.BloodType
	Value=[None|Full], Default=[None]
	Controls access to the "Blood Type" lookup table editor. Added in v3.2018.3

	Config.LookupEditor.BodyPart
	Value=[None|Full], Default=[None]
	Controls access to the "Body Part" lookup table editor. 

	Config.LookupEditor.BreastDensity
	Value=[None|Full], Default=[None]
	Controls access to the "Breast Density" lookup table editor. 

	Config.LookupEditor.BrowserConfig
	Value=[None|Full], Default=[None]
	Controls access to the "Browser Configuration" lookup table editor used by the Portal Integration window. 

	Config.LookupEditor.BrowserType
	Value=[None|Full], Default=[None]
	Controls access to the "Browser Type" lookup table editor. 

	Config.LookupEditor.BulkReProcessEligibility
	Value=[None|ReadOnly|Full], Default=[None]
	Controls access to the "Reprocess Eligibility" screen within the Eligibility Special Conditions or Insurance Service Type Rules lookup table editor. When [Full] the screen is enabled. When [ReadOnly], the button will be available but the "Reprocess Eligibility" screen will be read-only. Added in v3.2018.5.5 #27205

	Config.LookupEditor.CanceledStudyReason
	Value=[None|Full], Default=[None]
	Controls access to the "Canceled Study Reason" lookup table editor. 

	Config.LookupEditor.Carrier
	Value=[None|Full], Default=[None]
	Controls access to the "Carrier" lookup table editor. 

	Config.LookupEditor.CarrierCategory
	Value=[None|Full], Default=[None]
	Controls access to the "CarrierCategory" lookup table editor indicating AUC assessment outcome statuses. Added in v3.2018.5.2

	Config.LookupEditor.CarrierType
	Value=[None|Full], Default=[None]
	Controls access to the "Carrier Type" lookup table editor. 

	Config.LookupEditor.CategoryGroup
	Value=[None|Full], Default=[None]
	Controls access to the "Category Groups" lookup table editor. 

	Config.LookupEditor.CDSMIntegration
	Value=[None|Full], Default=[None]
	Controls access to the "CDSMIntegration" lookup table editor. Added in v3.2021.10.25 #30603

	Config.LookupEditor.Chair
	Value=[None|Full], Default=[None]
	Controls access to the "Chair" lookup table editor. 

	Config.LookupEditor.ChangeLogControl
	Value=[None|Full], Default=[None]
	Controls access to the "ChangeLog" lookup table editor. Added in v3.2018.5.6 #9141

	Config.LookupEditor.ClinicalTask
	Value=[None|Full], Default=[None]
	Controls access to the "ClinicalTask" lookup table editor. Added in v3.2018.2

	Config.LookupEditor.Complication
	Value=[None|Full], Default=[None]
	Controls access to the "Complication" lookup table editor. 

	Config.LookupEditor.Condition
	Value=[None|Full], Default=[None]
	Controls access to the "Condition" lookup table editor. 

	Config.LookupEditor.ConditionalTab
	Value=[None|Full], Default=[None]
	Controls access to the "Conditional Tab" lookup table editor. 

	Config.LookupEditor.ConfigFile
	Value=[None|Full], Default=[None]
	Controls access to the "Configuration Files" lookup table editor. 

	Config.LookupEditor.ConfirmationStatus
	Value=[None|Full], Default=[None]
	Controls access to the "Confirmation Status" lookup table editor. 

	Config.LookupEditor.ContactLogMethod
	Value=[None|Full], Default=[None]
	Controls access to the "Contact Log Method" lookup table editor. 

	Config.LookupEditor.ContactMethod
	Value=[None|Full], Default=[None]
	Controls access to the "Contact Method" lookup table editor. 

	Config.LookupEditor.Contrast
	Value=[None|Full], Default=[None]
	Controls access to the "Contrast" lookup table editor. 

	Config.LookupEditor.CountryState
	Value=[None|Full], Default=[None]
	Controls access to the "Country State" lookup table editor. 

	Config.LookupEditor.CreatedBySystem
	Value=[None|Full], Default=[None]
	Controls access to the "Created By System" lookup table editor. 

	Config.LookupEditor.CreditCardType
	Value=[None|Full], Default=[None]
	Controls access to the "Credit Card Type" lookup table editor. 

	Config.LookupEditor.CTRMCategory
	Value=[None|Full], Default=[None]
	Controls access to the "CTRM Category" lookup table editor. 

	Config.LookupEditor.CustomIntegrationFile
	Value=[None|Full], Default=[None]
	Controls access to the Access to the Custom Integration File lookup. Added in v3.2018.2

	Config.LookupEditor.DeliveryMethod
	Value=[None|Full], Default=[None]
	Controls access to the "Delivery Method" lookup table editor. 

	Config.LookupEditor.Department
	Value=[None|Full], Default=[None]
	Controls access to the "Department" lookup table editor. Added in v3.2018.5.1

	Config.LookupEditor.DetailedCodingStatus
	Value=[None|Full], Default=[None]
	Controls access to the "Detailed Coding Status" lookup table editor. 

	Config.LookupEditor.DictationArchiveLocation
	Value=[None|Full], Default=[None]
	Controls access to the "Dictation Archive Location" lookup table editor. 

	Config.LookupEditor.DigitalForms
	Value=[None|Full], Default=[None]
	Controls access to the "Digital Forms" lookup table editor. 

	Config.LookupEditor.DigitalFormsMask
	Value=[None|Full], Default=[None]
	Controls access to the "Digital Forms Mask" lookup table editor. 

	Config.LookupEditor.DocumentDeleteReason
	Value=[None|Full], Default=[None]
	Controls access to the "Document Delete Reason" lookup table editor. 

	Config.LookupEditor.DocumentType
	Value=[None|Full], Default=[None]
	Controls access to the "Document Type" lookup table editor. 

	Config.LookupEditor.DosageUnit
	Value=[None|Full], Default=[None]
	Controls access to the "Dosage Unit" lookup table editor. 

	Config.LookupEditor.DrugAllergyType
	Value=[None|Full], Default=[None]
	Controls access to the "Drug Allergy Type" lookup table editor. 

	Config.LookupEditor.EducationLevel
	Value=[None|Full], Default=[None]
	Controls access to the "Education Level" lookup table editor. 

	Config.LookupEditor.EligibilityLimitPayment
	Value=[None|Full], Default=[None]
	Controls access to the "Eligibility Limit Payment" lookup table editor. 

	Config.LookupEditor.EligibilityMessage
	Value=[None|Full], Default=[None]
	Controls access to the "Eligibility Message" lookup table editor. 

	Config.LookupEditor.EligibilitySpecialCondition
	Value=[None|Full], Default=[None]
	Controls access to the "Eligibility Special Conditions" lookup table editor. 

	Config.LookupEditor.EligibleConfig
	Value=[None|Full], Default=[None]
	Controls access to the "Eligible Config" lookup table editor. 

	Config.LookupEditor.EligiblePayers
	Value=[None|Full], Default=[None]
	Controls access to the "Eligible Payers" lookup table editor. 

	Config.LookupEditor.EmployerDirect
	Value=[None|Full], Default=[None]
	Controls access to the "Employer Direct" lookup table editor. 

	Config.LookupEditor.EmploymentStatus
	Value=[None|Full], Default=[None]
	Controls access to the "Employment Status" lookup table editor. 

	Config.LookupEditor.EMR
	Value=[None|Full], Default=[None]
	Controls access to the "EMR" lookup table editor. 

	Config.LookupEditor.EthnicOrigin
	Value=[None|Full], Default=[None]
	Controls access to the "Ethnic Origin" lookup table editor. 

	Config.LookupEditor.ExamPriority
	Value=[None|Full], Default=[None]
	Controls access to the "Exam Priority (lookup not active)" lookup table editor. 

	Config.LookupEditor.ExpiringReservation
	Value=[None|Full], Default=[None]
	Controls access to the "Expiring Reservation" lookup table editor. 

	Config.LookupEditor.Explanation
	Value=[None|Full], Default=[None]
	Controls access to the "Explanation" lookup table editor for the PreApproved Payment workflow. Added in v3.2021.6.7 #29943

	Config.LookupEditor.ExternalReportingSystem
	Value=[None|Full], Default=[None]
	Controls access to the "External Reporting System" lookup table editor. 

	Config.LookupEditor.FamilyHistory
	Value=[None|Full], Default=[None]
	Controls access to the "MU Family History" lookup table editor. 

	Config.LookupEditor.FamilyRelation
	Value=[None|Full], Default=[None]
	Controls access to the "MU Family Relation" lookup table editor. 

	Config.LookupEditor.FeeSchedule
	Value=[None|Full], Default=[None]
	Controls access to the "FeeSchedule" lookup table editor including "Fee" sub-table. Added in v3.2022.8.29 #31035

	Config.LookupEditor.FinancialOverrideSource
	Value=[None|Full], Default=[None]
	Controls access to the "Financial Override Source" lookup table editor. 

	Config.LookupEditor.Finding
	Value=[None|Full], Default=[None]
	Controls access to the "Finding and Follow Up" lookup table editor. 

	Config.LookupEditor.Firmware
	Value=[None|Full], Default=[None]
	Controls access to the "Firmware" lookup table editor. 

	Config.LookupEditor.FollowUpResolvedReason
	Value=[None|Full], Default=[None]
	Controls access to the "Follow Up Resolved Reason" lookup table editor. 

	Config.LookupEditor.FollowUpType
	Value=[None|Full], Default=[None]
	Controls access to the "Follow Up Type" lookup table editor. 

	Config.LookupEditor.FormCategory
	Value=[None|Full], Default=[None]
	Controls access to the "Form Category" lookup table editor. 

	Config.LookupEditor.FormsAndLabels
	Value=[None|Full], Default=[None]
	Controls access to the "Forms and Labels" lookup table editor. 

	Config.LookupEditor.Gender
	Value=[None|Full], Default=[None]
	Controls access to the "Gender" lookup table editor. 

	Config.LookupEditor.GenderIdentity
	Value=[None|Full], Default=[None]
	Controls access to the "Gender Identity" lookup table editor. 

	Config.LookupEditor.GeneralDescription
	Value=[None|Full], Default=[None]
	Controls access to the "Procedure General Description" lookup table editor (note the spelling). 

	Config.LookupEditor.Goal
	Value=[None|Full], Default=[None]
	Controls access to the "Goal" lookup table editor. 

	Config.LookupEditor.HL7v3Vocabulary
	Value=[None|Full], Default=[None]
	Controls access to the "HL7v3 Vocabulary" lookup table editor. 

	Config.LookupEditor.Holiday
	Value=[None|Full], Default=[None]
	Controls access to the "Holiday" lookup table editor. 

	Config.LookupEditor.IdVerificationMethod
	Value=[None|Full], Default=[None]
	Controls access to the "ID Verification Method" lookup table editor. Added in v3.2018.3

	Config.LookupEditor.ImageMedium
	Value=[None|Full], Default=[None]
	Controls access to the "Image Medium" lookup table editor. 

	Config.LookupEditor.ImageUploader
	Value=[None|Full], Default=[None]
	Controls access to the "Image Uploader" lookup table editor. 

	Config.LookupEditor.ImagineChargeAuditNote
	Value=[None|Full], Default=[None]
	Controls access to the "ImagineChargeAuditNote" lookup table editor. 

	Config.LookupEditor.ImagingCenter
	Value=[None|Full], Default=[None]
	Controls access to the "Image Centers" lookup table editor for the sites displayed on the Patient and Provider Portals. 

	Config.LookupEditor.ImmunizationBody
	Value=[None|Full], Default=[None]
	Controls access to the "Immunization Body" lookup table editor. 

	Config.LookupEditor.ImmunizationRoute
	Value=[None|Full], Default=[None]
	Controls access to the "Immunization Route" lookup table editor. 

	Config.LookupEditor.ImplantDevice
	Value=[None|Full], Default=[None]
	Controls access to the "Implant Device" lookup table editor. 

	Config.LookupEditor.InboundStatus
	Value=[None|Full], Default=[None]
	Controls access to the "Inbound Document Status" lookup table editor. Added in v3.2022.1.17 #29161

	Config.LookupEditor.Indication
	Value=[None|Full], Default=[None]
	Controls access to the "Indication" lookup table editor. 

	Config.LookupEditor.InjurySource
	Value=[None|Full], Default=[None]
	Controls access to the "Injury Source" lookup table editor for portal users. 

	Config.LookupEditor.InsuranceServiceType
	Value=[None|Full], Default=[None]
	Controls access to the "Insurance Service Type" lookup table editor. 

	Config.LookupEditor.InsuranceServiceTypeRule
	Value=[None|Full], Default=[None]
	Controls access to the "Insurance Service Type Rule" lookup table editor. 

	Config.LookupEditor.InsuranceVerificationRequired
	Value=[None|Full], Default=[None]
	Controls access to the "Insurance Verification Required" lookup table editor. 

	Config.LookupEditor.Issuer
	Value=[None|Full], Default=[None]
	Controls access to the "Issuer Lookup" lookup table editor that contains the issues user can manually use when adding and removing an MRN. 

	Config.LookupEditor.LabObservation
	Value=[None|Full], Default=[None]
	Controls access to the "Lab Observation" lookup table editor. 

	Config.LookupEditor.LabProvider
	Value=[None|Full], Default=[None]
	Controls access to the "Lab Provider" lookup table editor. 

	Config.LookupEditor.LabTest
	Value=[None|Full], Default=[None]
	Controls access to the "Lab Test" lookup table editor. 

	Config.LookupEditor.Language
	Value=[None|Full], Default=[None]
	Controls access to the "Language" lookup table editor used to select a patient's language preference. 

	Config.LookupEditor.Laterality
	Value=[None|Full], Default=[None]
	Controls access to the "Laterality" lookup table editor. 

	Config.LookupEditor.LegacyReportArchive
	Value=[None|Full], Default=[None]
	Controls access to the "Legacy Report Archive" lookup table editor. 

	Config.LookupEditor.LegacyUserId
	Value=[None|Full], Default=[None]
	Controls access to the "LegacyUserID" lookup table editor. Added in v3.2022.1.17

	Config.LookupEditor.LegalAuthenticator
	Value=[None|Full], Default=[None]
	Controls access to the "Legal Authenticator" lookup table editor. 

	Config.LookupEditor.LegalDocument
	Value=[None|Full], Default=[None]
	Controls access to the "Legal Document" lookup table editor. 

	Config.LookupEditor.LogControl
	Value=[None|Full], Default=[None]
	Controls access to the "Log Control" lookup table editor. 

	Config.LookupEditor.LookupLocalization
	Value=[None|Full], Default=[None]
	Controls the ability to view, import, and export configured localized strings. 

	Config.LookupEditor.MammoBiopsyStage
	Value=[None|Full], Default=[None]
	Controls access to the "Mammo Biopsy Stage" lookup table editor. 

	Config.LookupEditor.MammoBiopsyTechnique
	Value=[None|Full], Default=[None]
	Controls access to the "Mammo Biopsy Technique" lookup table editor. 

	Config.LookupEditor.MammoLetterConfig
	Value=[None|Full], Default=[None]
	Controls access to the "Mammo Letter Configuration" lookup table editor. 

	Config.LookupEditor.MammoType
	Value=[None|Full], Default=[None]
	Controls access to the "Mammo Type" lookup table editor. 

	Config.LookupEditor.ManagementReportMaxTimes
	Value=[None|Full], Default=[None]
	Controls access to the "Management Report Max Time" lookup table (l_management_report_max_time). 

	Config.LookupEditor.MaritalStatus
	Value=[None|Full], Default=[None]
	Controls access to the "Marital Status" lookup table editor. 

	Config.LookupEditor.MarketingDomains
	Value=[None|Full], Default=[None]
	Controls access to the "Marketing Domains" lookup table editor for use by site groups. 

	Config.LookupEditor.MedicalGroup
	Value=[None|Full], Default=[None]
	Controls access to the "Medical Group" lookup table editor. 

	Config.LookupEditor.MedicalGroupContactType
	Value=[None|Full], Default=[None]
	Controls access to the "Medical Group Contact Type" lookup table editor. 

	Config.LookupEditor.Medication
	Value=[None|Full], Default=[None]
	Controls access to the "Medication" lookup table editor. 

	Config.LookupEditor.MessageGroup
	Value=[None|Full], Default=[None]
	Controls access to the "Message Groups" lookup table editor. 

	Config.LookupEditor.MModalDocumentModel
	Value=[None|Full], Default=[None]
	Controls access to the "MModal Document Model" lookup table editor. 

	Config.LookupEditor.Modality.ViewAllPractices
	Value=[None|Full], Default=[None]
	Controls the ability to view and edit all rooms across all practices for modality editor users. 

	Config.LookupEditor.Modality
	Value=[None|Full], Default=[None]
	Controls access to the "Modality" lookup table editor. 

	Config.LookupEditor.ModalityGroup
	Value=[None|Full], Default=[Full]
	Controls access to the "Modality Group" lookup table editor. Added in v3.2018.2

	Config.LookupEditor.ModalityType
	Value=[None|Full], Default=[None]
	Controls access to the "Modality Type" lookup table editor. 

	Config.LookupEditor.MRIMagnetType
	Value=[None|Full], Default=[None]
	Controls access to the "MRIMagnetType" lookup table editor. Added in v3.2022.2.14 #30981

	Config.LookupEditor.MultiInsuranceRule
	Value=[None|Full], Default=[None]
	Controls access to the "MultiInsuranceRule" lookup table editor. Added in v3.2018.5.6 #28108

	Config.LookupEditor.NatureOfInjury
	Value=[None|Full], Default=[None]
	Controls access to the "Nature of Injury" lookup table editor. 

	Config.LookupEditor.NetworkPrinter
	Value=[None|Full], Default=[None]
	Controls access to the "Network Printer" lookup table editor. 

	Config.LookupEditor.ObservationResult
	Value=[None|Full], Default=[None]
	Controls access to the "Observation Result" lookup table editor. 

	Config.LookupEditor.OrderCategory
	Value=[None|Full], Default=[None]
	Controls access to the "Order Category" lookup table editor. Added in v3.2021.5.24.4 #30499

	Config.LookupEditor.OrderExtraInfo
	Value=[None|Full], Default=[None]
	Controls access to the "Order Extra Info" lookup table editor. 

	Config.LookupEditor.OrderingOrganization
	Value=[None|Full], Default=[None]
	Controls access to the "Ordering Organization" lookup table editor. 

	Config.LookupEditor.Organization.Portal.AdditionalConfiguration
	Value=[None|Full], Default=[None]
	Controls the ability to add or edit portal configuration overrides for the image group. 

	Config.LookupEditor.Organization
	Value=[None|Full], Default=[None]
	Controls access to the "Organization" lookup table editor. 

	Config.LookupEditor.OverbookReason
	Value=[None|Full], Default=[None]
	Controls access to the "Overbook Reason" lookup table editor. 

	Config.LookupEditor.PACSServer
	Value=[None|Full], Default=[None]
	Controls access to the "PACS Server" lookup table editor. 

	Config.LookupEditor.ParagraphConfig
	Value=[None|Full], Default=[None]
	Controls access to the "Paragraph Config" lookup table editor. Added in v3.2018.2

	Config.LookupEditor.Pathology
	Value=[None|Full], Default=[None]
	Controls access to the "Pathology" lookup table editor. 

	Config.LookupEditor.PatientAlert
	Value=[None|Full], Default=[None]
	Controls access to the "Patient Alert" lookup table editor. 

	Config.LookupEditor.PatientClass
	Value=[None|Full], Default=[None]
	Controls access to the "Patient Class" lookup table editor. 

	Config.LookupEditor.PatientContactType
	Value=[None|Full], Default=[None]
	Controls access to the "Patient Contact Type" lookup table editor. 

	Config.LookupEditor.PatientExtraInfo
	Value=[None|Full], Default=[None]
	Controls access to the "Patient Extra Info" lookup table editor. Added in v3.2018.3

	Config.LookupEditor.PatientPrefix
	Value=[None|Full], Default=[None]
	Controls access to the "Patient Prefix" lookup table editor. 

	Config.LookupEditor.PatientRelation
	Value=[None|Full], Default=[None]
	Controls access to the "Patient Relation" lookup table editor. 

	Config.LookupEditor.PatientSuffix
	Value=[None|Full], Default=[None]
	Controls access to the "Patient Suffix" lookup table editor. 

	Config.LookupEditor.PersonExtraInfo
	Value=[None|Full], Default=[None]
	Controls access to the "PersonExtraInfo" lookup table editor. Added in v3.2018.2

	Config.LookupEditor.Personnel.ConfirmedRadiologistFlag
	Value=[None|Full], Default=[None]
	Controls access to the "Confirmed Radiologist Flag" lookup table editor. 

	Config.LookupEditor.Personnel.DomainAuthentication
	Value=[None|Full], Default=[Full]
	Controls the ability to change a users authentication type. 

	Config.LookupEditor.Personnel.EmailPassword
	Value=[None|Full], Default=[None]
	Controls the ability to view personnel address distribution email passwords. 

	Config.LookupEditor.Personnel.GrantPrivilegedUserGroup
	Value=[None|Full], Default=[None]
	Controls the ability to grant privileged user groups to a user profile. Added in v3.2022.4.25 #30889

	Config.LookupEditor.Personnel.PersonNotes
	Value=[None|Full], Default=[None]
	Controls the ability to change previous Person Notes. 

	Config.LookupEditor.Personnel
	Value=[None|Full], Default=[None]
	Controls access to the "Personnel" lookup table editor. 

	Config.LookupEditor.PersonnelReferring
	Value=[None|Full], Default=[None]
	Controls access to the "Personnel Referring" lookup table editor. 

	Config.LookupEditor.PersonResource
	Value=[None|Full], Default=[None]
	Controls access to the "Person Resource" lookup table editor. 

	Config.LookupEditor.PIXPDQServers
	Value=[None|Full], Default=[None]
	Controls access to the "PIXPDQ lookup servers" lookup table editor. 

	Config.LookupEditor.PortalEMRURLCypher
	Value=[None|Full], Default=[None]
	Controls access to the "PortalEMRURLCypher" lookup table editor containing decryption cyphers used by EMR URLs related to each Millenger Portal instance. Added in v3.2021.12.20 #30552

	Config.LookupEditor.PortalProcedureGroup
	Value=[None|Full], Default=[None]
	Controls access to the "Portal Procedure Group" lookup table editor. 

	Config.LookupEditor.PracticeExtraInfo
	Value=[None|Full], Default=[None]
	Controls access to the "Practice Extra Info" lookup table editor. Added in v3.2018.5.5 #24802

	Config.LookupEditor.PracticeSiteXProcedureOverride
	Value=[None|Full], Default=[None]
	Controls access to the "Practice Site X Procedure Override" lookup table editor. 

	Config.LookupEditor.PreApprovedPaymentRule
	Value=[None|Full], Default=[None]
	Controls access to the "PreApprovedPaymentRule" lookup table editor. Added in v3.2021.5.24 #27641

	Config.LookupEditor.PreCertDetails
	Value=[None|Full], Default=[None]
	Controls access to the "PreCertDetails" lookup table editor. Added in v3.2018.5.5 #25018

	Config.LookupEditor.PreCertGroups
	Value=[None|Full], Default=[None]
	Controls access to the "PreCert Groups" lookup table editor. 

	Config.LookupEditor.PrepInstruction
	Value=[None|Full], Default=[None]
	Controls access to the "Prep Instruction" lookup table editor. 

	Config.LookupEditor.PrepInstructionType
	Value=[None|Full], Default=[None]
	Controls access to the "Prep Instruction Type" lookup table editor. 

	Config.LookupEditor.PrinterConfig
	Value=[None|Full], Default=[None]
	Controls access to the "Printer Config" lookup table editor. 

	Config.LookupEditor.ProcedureChangeReason
	Value=[None|Full], Default=[None]
	Controls access to the "Procedure Change Reason" lookup table editor. 

	Config.LookupEditor.ProcedureCode
	Value=[None|Full], Default=[None]
	Controls access to the "Procedure Code" lookup table editor. 

	Config.LookupEditor.ProcedureCodeReplacement
	Value=[None|Full], Default=[None]
	Controls access to the "Procedure Code Replacement" lookup table editor. 

	Config.LookupEditor.ProcedureExamTitle
	Value=[None|Full], Default=[None]
	Controls access to the "Procedure Exam Title" lookup table editor. 

	Config.LookupEditor.ProcedureGeneralDescription
	Value=[None|Full], Default=[None]
	Controls access to the "Procedure General Description" lookup table editor. 

	Config.LookupEditor.ProcedureGroup
	Value=[None|Full], Default=[None]
	Controls access to the "Procedure Group" lookup table editor. 

	Config.LookupEditor.ProcedureModifier
	Value=[None|Full], Default=[None]
	Controls access to the "Procedure Modifier" lookup table editor. 

	Config.LookupEditor.ProcedurePicker
	Value=[None|Full], Default=[None]
	Controls access to the "Patient Portal Procedure Picker configuration" lookup table editor. 

	Config.LookupEditor.ProcedurePlan
	Value=[None|Full], Default=[None]
	Controls access to the "Procedure Plan" lookup table editor. 

	Config.LookupEditor.ProcedurePlanExamTitle
	Value=[None|Full], Default=[None]
	Controls access to the "ProcedurePlanExamTitle" lookup table editor. Added in v3.2018.5.1

	Config.LookupEditor.ProcedurePlanTechnique
	Value=[None|Full], Default=[None]
	Controls access to the "ProcedurePlanTechnique" lookup table editor. Added in v3.2018.5.1

	Config.LookupEditor.ProcedureTechnique
	Value=[None|Full], Default=[None]
	Controls access to the "Procedure Technique" lookup table editor. 

	Config.LookupEditor.ProtocolRules
	Value=[None|Full], Default=[None]
	Controls access to the "Protocol Rules" lookup table editor. Added in v3.2018.3

	Config.LookupEditor.ProtocolStatus
	Value=[None|Full], Default=[None]
	Controls access to the "Protocol Status" lookup table editor. Added in v3.2018.3

	Config.LookupEditor.QualityReviewDistribution
	Value=[None|Full], Default=[None]
	Controls access to the "Quality Review Distribution" lookup table editor. 

	Config.LookupEditor.QueueSubscription
	Value=[None|Full], Default=[None]
	Controls access to the "Queue Subscription" lookup table editor. 

	Config.LookupEditor.RaceType
	Value=[None|Full], Default=[None]
	Controls access to the "Race Type" lookup table editor. 

	Config.LookupEditor.RadPeerReviewAssignment
	Value=[None|Full], Default=[None]
	Controls access to the "Rad Peer Review Assignment" lookup table editor. 

	Config.LookupEditor.RadSignLevel
	Value=[None|Full], Default=[None]
	Controls access to the "Radiologist Sign Level" lookup table editor. 

	Config.LookupEditor.ReadingGroup
	Value=[None|Full], Default=[None]
	Controls access to the "Reading Group" lookup table editor. 

	Config.LookupEditor.ReadingPriority
	Value=[None|Full], Default=[None]
	Controls access to the "Reading Priority (lookup not active)" lookup table editor. 

	Config.LookupEditor.Recommendation
	Value=[None|Full], Default=[None]
	Controls access to the "Recommendation" lookup table editor. 

	Config.LookupEditor.ReferringAddresses
	Value=[None|Full], Default=[None]
	Controls access to the "Referring Addresses" lookup table editor (requires Config.LookupEditor.Personnel). 

	Config.LookupEditor.ReferringPractice
	Value=[None|Full], Default=[None]
	Controls access to the "the Referring Practices" lookup table editor. 

	Config.LookupEditor.Relevance
	Value=[None|Full], Default=[None]
	Controls access to the "Relevance" lookup table editor. 

	Config.LookupEditor.Religion
	Value=[None|Full], Default=[None]
	Controls access to the "Religion" lookup table editor. 

	Config.LookupEditor.ReportingOption
	Value=[None|Full], Default=[None]
	Controls access to the "Reporting Option" lookup table editor. 

	Config.LookupEditor.ReportPermissions
	Value=[None|Full], Default=[None]
	Controls access to the "Report Permissions" lookup table editor. 

	Config.LookupEditor.ReportTemplate
	Value=[None|Full], Default=[None]
	Controls access to the "Report Template" lookup table editor. 

	Config.LookupEditor.ReportTemplateCDA
	Value=[None|Full], Default=[None]
	Controls access to the "Report Template CDA" lookup table editor. 

	Config.LookupEditor.ResourceProcedureGroup
	Value=[None|Full], Default=[None]
	Controls access to the "Resource Procedure Group" lookup table editor. Added in v3.2018.5.1

	Config.LookupEditor.ResourceType
	Value=[None|Full], Default=[None]
	Controls access to the "Resource Type" lookup table editor. 

	Config.LookupEditor.ScanDocumentArchiveLocation
	Value=[None|Full], Default=[None]
	Controls access to the "Scan Document Archive Location" lookup table editor. 

	Config.LookupEditor.ScanType
	Value=[None|Full], Default=[None]
	Controls access to the "Scan Type" lookup table editor. 

	Config.LookupEditor.ScanTypeGroup
	Value=[None|Full], Default=[None]
	Controls access to the "ScanTypeGroup" lookup table editor. Added in v3.2022.6.20 #30921

	Config.LookupEditor.ScheduledTask
	Value=[None|Full], Default=[None]
	Controls access to the "Scheduled Task" lookup table editor. 

	Config.LookupEditor.ScheduleGroup
	Value=[None|Full], Default=[None]
	Controls access to the "Schedule Group" lookup table editor. 

	Config.LookupEditor.SearchProviders
	Value=[None|Full], Default=[None]
	Controls access to the "Search Providers" lookup table editor. 

	Config.LookupEditor.SecurityQuestion
	Value=[None|Full], Default=[None]
	Controls access to the "creating available security questions" lookup table editor for portal users. 

	Config.LookupEditor.SedationType
	Value=[None|Full], Default=[None]
	Controls access to the "Sedation Type" lookup table editor. 

	Config.LookupEditor.Sedative
	Value=[None|Full], Default=[None]
	Controls access to the "Sedative" lookup table editor. 

	Config.LookupEditor.SexualOrientation
	Value=[None|Full], Default=[None]
	Controls access to the "Sexual Orientation" lookup table editor. 

	Config.LookupEditor.SiteExtraInfo
	Value=[None|Full], Default=[None]
	Controls access to the "Site Extra Info" lookup table editor. Added in v3.2018.5.5 #24803

	Config.LookupEditor.SiteGroup
	Value=[None|Full], Default=[None]
	Controls access to the "Site Group" lookup table editor. 

	Config.LookupEditor.SkipPeerReviewReason
	Value=[None|Full], Default=[None]
	Controls access to the "Skip Peer Review Reason" lookup table editor. 

	Config.LookupEditor.SmokingStatus
	Value=[None|Full], Default=[None]
	Controls access to the "Smoking Status (this is a hidden table and cannot be accessed through the Configure window)" lookup table editor. 

	Config.LookupEditor.SpecialAccommodations
	Value=[None|Full], Default=[None]
	Controls access to the "Special Accommodations" lookup table editor. 

	Config.LookupEditor.Specialty
	Value=[None|Full], Default=[None]
	Controls access to the "Specialty" lookup table editor. 

	Config.LookupEditor.SpecimenAction
	Value=[None|Full], Default=[None]
	Controls access to the "Specimen Action" lookup table editor. 

	Config.LookupEditor.SpecimenCondition
	Value=[None|Full], Default=[None]
	Controls access to the "Specimen Condition" lookup table editor. 

	Config.LookupEditor.SpecimenQuality
	Value=[None|Full], Default=[None]
	Controls access to the "Specimen Quality" lookup table editor. 

	Config.LookupEditor.SpecimenType
	Value=[None|Full], Default=[None]
	Controls access to the "Specimen Type" lookup table editor. 

	Config.LookupEditor.StudentStatus
	Value=[None|Full], Default=[None]
	Controls access to the "Student Status" lookup table editor. Note: Lookup not active. 

	Config.LookupEditor.StudyExtraInfo
	Value=[None|Full], Default=[None]
	Controls access to the "Study Extra Info" lookup table editor. 

	Config.LookupEditor.StudyUpdateResponseInclusions
	Value=[None|Full], Default=[None]
	Controls access to the "Study Update Response Inclusions" lookup table editor. 

	Config.LookupEditor.SystemConfig
	Value=[None|Full], Default=[None]
	Controls access to the "System Config" lookup table editor. 

	Config.LookupEditor.SystemMessage
	Value=[None|Full], Default=[None]
	Controls access to the "System Messages" lookup table editor (currently used for portal). 

	Config.LookupEditor.TemplateMacro
	Value=[None|Full], Default=[None]
	Controls access to the "Template Macro" lookup table editor. 

	Config.LookupEditor.TimeZone
	Value=[None|Full], Default=[None]
	Controls access to the "Time Zone" lookup table editor. 

	Config.LookupEditor.UMCoverage
	Value=[None|Full], Default=[None]
	Controls access to the "UM Coverage" lookup table editor. 

	Config.LookupEditor.UMHoliday
	Value=[None|Full], Default=[None]
	Controls access to the "UM Holiday" lookup table editor. 

	Config.LookupEditor.UMResolution
	Value=[None|Full], Default=[None]
	Controls access to the "UM Resolution" lookup table editor. 

	Config.LookupEditor.UMStatus
	Value=[None|Full], Default=[None]
	Controls access to the "UM Status" lookup table editor. 

	Config.LookupEditor.UnitOfMeasure
	Value=[None|Full], Default=[None]
	Controls access to the "Unit of Measure" lookup table editor. 

	Config.LookupEditor.UrgencyLevel
	Value=[None|Full], Default=[None]
	Controls access to the "Order Urgency Level" lookup table editor. 

	Config.LookupEditor.UserCDSProfile
	Value=[None|Full], Default=[None]
	Controls access to the "User CDS Profile" lookup table editor. 

	Config.LookupEditor.UserDetail
	Value=[None|Full], Default=[None]
	Controls access to the "User Detail (lookup not active)" lookup table editor. 

	Config.LookupEditor.UserGroup
	Value=[None|Full], Default=[None]
	Controls access to the "User Group" lookup table editor. 

	Config.LookupEditor.UserGroupPermission
	Value=[None|Full], Default=[None]
	Controls access to the "User Group Permission" lookup table editor. 

	Config.LookupEditor.Vaccine
	Value=[None|Full], Default=[None]
	Controls access to the "Vaccine" lookup table editor. 

	Config.LookupEditor.VaccineManufacturer
	Value=[None|Full], Default=[None]
	Controls access to the "Vaccine Manufacturer" lookup table editor. 

	Config.LookupEditor.ValidationRules
	Value=[None|Full], Default=[None]
	Controls access to the "Validation Rules" lookup table editor. 

	Config.LookupEditor.WorklistControl
	Value=[None|Full], Default=[None]
	Controls access to the "WorklistControl" lookup table editor. Added in v3.2018.5.5 #27771

	Config.LookupEditor.WorklistDisabled
	Value=[None|Full], Default=[None]
	Controls access to the "WorklistDisabled" lookup table editor. Added in v3.2018.5.6 #27969

	Config.LookupEditor.WorklistPreference
	Value=[None|Full], Default=[None]
	Controls access to the "Worklist Preference" lookup table editor. 

	Config.LookupEditor.WorkType
	Value=[None|Full], Default=[None]
	Controls access to the "Work Type" lookup table editor. 

	Config.LookupEditor.WorkUnit
	Value=[None|Full], Default=[None]
	Controls access to the "Work Unit" lookup table editor. 

	Config.LookupEditor
	Value=[None|Full], Default=[Full]
	Controls access to the lookup table editor. 

	Config.ManagementReports.RADAR
	Value=[None|Full], Default=[None]
	Controls access to the Access to RADAR Client Portal from the management reports screen. Added in v3.2018.2

	Config.ManagementReports
	Value=[None|Full], Default=[None]
	Controls access to the "Management Reports" menu item from the Administration menu. 

	Config.MessageInbox
	Value=[None|Full], Default=[None]
	Controls access to the Secure Message Inbox. 

	Config.PowerScribe360TestHarness
	Value=[None|Full], Default=[None]
	Controls access to the "developers and advanced support users" menu item. 

	Config.RADARClientPortal
	Value=[None|Full], Default=[None]
	Controls access to the "RADAR Client Portal" menu item. 

	Config.TechSupportChangePassword
	Value=[None|Full], Default=[None]
	Controls the ability to change other user's passwords. Intended for helpdesk users who do not require full access to the Personnel Editor. 

	Config.TraceWorklistPerformance
	Value=[None|Full], Default=[None]
	Controls access to the "Enable Worklist Tracing" menu item from the Help menu. Added in v3.2021.12.20 #30577

	DataNugget.Attachments
	Value=[None|Full], Default=[None]
	Displays the "Documents" nugget. 

	DataNugget.Folder
	Value=[None|Full], Default=[Full]
	Displays the "Folder" nugget. 

	DataNugget.Impression
	Value=[None|Full], Default=[Full]
	Displays the "Impression" nugget. 

	DataNugget.Notes
	Value=[None|Full], Default=[None]
	Displays the "Notes" nugget. 

	DataNugget.Report
	Value=[None|Full], Default=[None]
	Displays the "Report" nugget. 

	DataNugget.Summary
	Value=[None|Full], Default=[None]
	Displays the "Summary" nugget. 

	Flag.Allergy
	Value=[None|Full], Default=[Full]
	Displays the "Allergy" flag. 

	Flag.AppointmentConflict
	Value=[None|Full], Default=[Full]
	Displays the "Appointment Conflict" flag. Added in v3.2018.3 #22704

	Flag.ApprovedAppointmentConflict
	Value=[None|Full], Default=[Full]
	Displays the "Approved Appointment Conflict" flag. Added in v3.2018.3 #22704

	Flag.AUCComplete
	Value=[None|Full], Default=[Full]
	Displays the "AUC Complete" flag. Added in v3.2018.5.2 24206

	Flag.AUCRequired
	Value=[None|Full], Default=[Full]
	Displays the "AUC Required" flag. Added in v3.2018.5.2 24206

	Flag.ClinicalTask
	Value=[None|Full], Default=[Full]
	Displays the "Clinical Task" flag. Added in v3.2018.3 #22704

	Flag.Contrast
	Value=[None|Full], Default=[Full]
	Displays the "Contrast" flag. 

	Flag.ContrastRequested
	Value=[None|Full], Default=[Full]
	Displays the "Contrast Requested" flag. 

	Flag.CTRMClosed
	Value=[None|Full], Default=[Full]
	Displays the "CTRM Closed" flag. Added in v3.2018.3 #22704

	Flag.CTRMPending
	Value=[None|Full], Default=[Full]
	Displays the "CTRM Pending" flag. Added in v3.2018.3 #22704

	Flag.DirectReferral
	Value=[None|Full], Default=[Full]
	Displays the "Direct Referral" flag. 

	Flag.EligibilityApproved
	Value=[None|Full], Default=[Full]
	Displays the "Eligibility Approved" flag. 

	Flag.EligibilityDenied
	Value=[None|Full], Default=[Full]
	Displays the "Eligibility Denied" flag. 

	Flag.EligibilityError
	Value=[None|Full], Default=[Full]
	Displays the "Eligibility Error" flag. 

	Flag.EligibilityInProgress
	Value=[None|Full], Default=[Full]
	Displays the "Eligibility in Progress" flag. 

	Flag.EligibilityWarnings
	Value=[None|Full], Default=[Full]
	Displays the "Eligibility Warnings" flag. 

	Flag.IVTRequired
	Value=[None|Full], Default=[Full]
	Displays the "IVT Required" flag. 

	Flag.LinkedStudy
	Value=[None|Full], Default=[Full]
	Displays the "Primary Linked Study" flag. 

	Flag.MarkedRead
	Value=[None|Full], Default=[Full]
	Displays the "Marked Read" flag. 

	Flag.MultipleStudies
	Value=[None|Full], Default=[Full]
	Displays the "Multiple Studies for today" flag. 

	Flag.Notes
	Value=[None|Full], Default=[Full]
	Displays the "Notes" flag. 

	Flag.PACSImagesPurged
	Value=[None|Full], Default=[Full]
	Displays the "PACS Images Purged" flag. 

	Flag.PreApprovalOnFile
	Value=[None|Full], Default=[Full]
	Displays the "PreApproved Payment On File" flag. Added in v3.2021.6.7 #29943

	Flag.PreApprovalRequired
	Value=[None|Full], Default=[Full]
	Displays the "PreApproved Payment Expected" flag. Added in v3.2021.6.7 #29943

	Flag.Pre-Auth
	Value=[None|Full], Default=[Full]
	Displays the "Pre-Auth" flag. 

	Flag.PrecertStat
	Value=[None|Full], Default=[Full]
	Displays the "Precert Stat" flag. 

	Flag.PrimaryLinkedStudy
	Value=[None|Full], Default=[Full]
	Displays the "Primary Linked Study" flag. 

	Flag.Problem
	Value=[None|Full], Default=[Full]
	Displays the "Problem" flag. 

	Flag.ProtocolCompleted
	Value=[None|Full], Default=[None]
	Displays the "Protocol Completed" flag. Added in v3.2018.3 #22704

	Flag.ProtocolDenied
	Value=[None|Full], Default=[None]
	Displays the "Protocol Denied" flag. Added in v3.2018.3 #22704

	Flag.ProtocolRequired
	Value=[None|Full], Default=[None]
	Displays the "Protocol Required" flag. Added in v3.2018.3 #22704

	Flag.QA
	Value=[None|Full], Default=[Full]
	Displays the "QA" flag. 

	Flag.SedationRequired
	Value=[None|Full], Default=[Full]
	Displays the "Sedation Required" flag. 

	Flag.Sequester
	Value=[None|Full], Default=[Full]
	Displays the "Sequester" flag. 

	Flag.SpecialAccommodations
	Value=[None|Full], Default=[Full]
	Displays the "Special Accommodations" flag. 

	Flag.StatExam
	Value=[None|Full], Default=[Full]
	Displays the "Stat Exam" flag. 

	Flag.StatRead
	Value=[None|Full], Default=[Full]
	Displays the "Stat Read" flag. 

	Flag.StudySuspended
	Value=[None|Full], Default=[Full]
	Displays the "Study Suspended" flag. 

	Flag.UMComplete
	Value=[None|Full], Default=[Full]
	Displays the "UM Complete" flag. 

	Flag.UMRequired
	Value=[None|Full], Default=[Full]
	Displays the "UM Required" flag. 

	MDW.OpenRIS
	Default=[]
	MDW can open the eRAD RIS ("Read only" == "disabled"). Note: Removed and no longer used. 

	Menu.Administration
	Value=[None|Full], Default=[None]
	Controls access to the "Administration" menu item. 

	Menu.CustomizeDataPanes
	Value=[None|Full], Default=[None]
	Controls access to the "customizing the look of a data pane" context menu. 

	Menu.Editor
	Value=[None|Full], Default=[None]
	Controls access to the "Editor" menu item. 

	Menu.File.UserPreferences
	Value=[None|Full], Default=[Full]
	Controls access to the "User Preference" menu item from the File menu. 

	Menu.File
	Value=[None|Full], Default=[Full]
	Controls access to the "File" main menu. 

	Menu.FrontDesk
	Value=[None|Full], Default=[None]
	Controls access to the "Front Desk" menu item. 

	Menu.Mammo
	Value=[None|Full], Default=[None]
	Controls access to the "Mammo" menu item. 

	Menu.Messaging
	Value=[None|Full], Default=[None]
	Controls access to the "Messaging" menu item. 

	Menu.PACS
	Value=[None|Full], Default=[None]
	Controls access to the "PACS" menu item. 

	Menu.Radiologist
	Value=[None|Full], Default=[None]
	Controls access to the "Radiologist" menu item. 

	Menu.Scheduling
	Value=[None|Full], Default=[None]
	Controls access to the "Scheduling" menu item. 

	Menu.Technologist
	Value=[None|Full], Default=[None]
	Controls access to the "Technologist" menu item. 

	MTW.OpenRIS
	Value=[None|Full], Default=[None]
	MTW can open eRAD RIS ("Read only" == "disabled"). Note: Removed and no longer used. 

	MTW.WorklistProblem
	Value=[None|Full], Default=[None]
	Controls access to the "Problem" worklist from MTW. Setting this value to Full will enable it for users. 

	MTW.WorklistQA
	Value=[None|Full], Default=[None]
	Controls access to the "QA" worklist from MTW. Setting this value to Full will enable it for users. 

	MU.CCDAScheduledTask
	Value=[None|Full], Default=[None]
	Controls access to the "Schedule C-CDA Export" menu item. 

	MU.ConfigureMeaningfulUse
	Value=[None|Full], Default=[None]
	Controls access to the "configuration screen" screen for Meaningful Use. 

	MU.eLabOrdering
	Default=[]
	Electronic Lab Ordering (Button no longer in use). Note: Removed and no longer used. 

	MU.ePrescribeAdministrator
	Value=[None|Full], Default=[None]
	Controls access to the "ePrescription (eRx) Administrator" role. 

	MU.ePrescribeRadiologist
	Value=[None|Full], Default=[None]
	Controls access to the "ePrescription (eRx) Radiologist" role. 

	MU.ePrescribeStaff
	Value=[None|Full], Default=[None]
	Controls access to the "ePrescription (eRx) Staff" role. 

	MU.ExportAll
	Value=[None|Full], Default=[None]
	Controls access to the "CCDA Export" feature that will export all C-CDA data to the system config location MU_ExportALL_Path (requires administrative access). 

	MU.MUEnabledControls
	Value=[None|Full], Default=[None]
	Controls access to the MU controls on a form (radio buttons and grids). 

	MU.QuickAddEddDialog
	Value=[None|Full], Default=[None]
	Controls access to the "Quick Add Edit" dialog from the MU tab. 

	MU.TransitionOfCare
	Default=[ReadOnly]
	Controls access to the "Transition of Care" checkbox. 

	Notification.PendingBiopsyNotify
	Value=[None|Full], Default=[Full]
	Controls the ability to show "worklist driven Pending Biopsy" notifcations. 

	Notification.PendingPeerReviewNotify
	Value=[None|Full], Default=[Full]
	Controls the ability to show "worklist-driven pending peer review" notifcations. 

	Notification.PendingSignatureWorklist
	Value=[None|Full], Default=[Full]
	Controls the ability to show "worklist driven Pending Signature" notifcations. 

	Notification.STATPendingSignature
	Value=[None|Full], Default=[Full]
	Controls the ability to show "STAT Case Pending Signature" notifcations. 

	Notification.STATPendingSignatureWorklist
	Value=[None|Full], Default=[Full]
	Controls the ability to show "worklist driven STAT Case Pending Signature" notifcations. 

	Notification.SuspendedNotify
	Value=[None|Full], Default=[Full]
	Controls the ability to show "Suspended" notifcations. 

	PACSIntegration.Disable
	Value=[None|Full], Default=[Full]
	Displays the "Disable" menu item from the PACS menu. 

	PACSIntegration.Enable
	Value=[None|Full], Default=[Full]
	Controls access to the "Enable" menu item. 

	PACSIntegration.Override
	Value=[None|Full], Default=[Full]
	Controls access to the "selecting a PACS Server" menu item from the PACS menu. 

	Portal.AuthLetter
	Value=[None|Full], Default=[None]
	Controls access to the "Auth Letter" tab for viewing documents. (see also: Portal.UMOpinionLetter). 

	Portal.CCDA
	Value=[None|Full], Default=[None]
	Displays the "CCDA" tab in the Provider Portal. when [Full] Users must also be assigned to that group. 

	Portal.MIM
	Value=[None|Full], Default=[None]
	Controls access to the "MIM" section in the Provider Portal. 

	Portal.PACS
	Value=[None|Full], Default=[None]
	Controls access to the "PACS" section in the Provider Portal. 

	Portal.Patient.Admin.CacheInfo
	Value=[None|Full], Default=[None]
	Controls access to the Cache Information from Patient Admin. 

	Portal.Patient.Admin.ConfigAccess
	Value=[None|Full], Default=[None]
	Controls access to the "App Config and Override" screen in the Patient Portal. Added in v3.2021.4.12 #29542

	Portal.Patient.Admin.TrainingMaterial
	Value=[None|Full], Default=[None]
	Controls access to the "Training Material" tab in the Patient Admin Portal. Added in v3.2021.11.22 #30445

	Portal.Patient.Admin
	Value=[None|Full], Default=[None]
	Controls access to the Patient Portal Administration login. 

	Portal.Referring.Admin.AccountMigration
	Value=[None|Full], Default=[None]
	Controls access to the "Account Migration" tab. 

	Portal.Referring.Admin.CacheInfo
	Value=[None|Full], Default=[None]
	Controls access to the Cache Information from Provider Admin Portal. 

	Portal.Referring.Admin.ConfigAccess
	Value=[None|Full], Default=[None]
	Controls access to the "App Config and Override" screen in the Provider Portal. Added in v3.2021.4.12 #29542

	Portal.Referring.Admin.ImgRetrieval
	Value=[None|Full], Default=[None]
	Controls access to the "Image Retrieval" tab. 

	Portal.Referring.Admin.MarketingCampaign
	Value=[None|Full], Default=[None]
	Controls access to the "Marketing Campaign" tab. Added in v3.2018.2

	Portal.Referring.Admin.SignUp
	Value=[None|Full], Default=[None]
	Controls access to the "Sign Up" tab from Provider Admin Portal. Added in v3.2021.10.25 #30605

	Portal.Referring.Admin.SysMsgs
	Value=[None|Full], Default=[None]
	Controls access to the "System Messages" tab. 

	Portal.Referring.Admin.TrainingMaterial
	Value=[None|Full], Default=[None]
	Controls access to the "Training Material" tab in the Provider Admin Portal. Added in v3.2021.11.22 #30445

	Portal.Referring.Admin.UserMgt.ADD
	Value=[None|Full], Default=[None]
	Controls the ability to add new accounts (requires administrative access). 

	Portal.Referring.Admin.UserMgt.CreateNewUser
	Value=[None|Full], Default=[None]
	Controls the ability to create new users (requires administrative access). 

	Portal.Referring.Admin.UserMgt
	Value=[None|Full], Default=[None]
	Controls access to the "User Management" tab. 

	Portal.Referring.Admin.UserMsgs
	Value=[None|Full], Default=[None]
	Controls access to the "User Messages" tab. 

	Portal.Referring.Admin
	Value=[None|Full], Default=[None]
	Controls access to the Provider Portal Administration login. 

	portal.referring.downloads
	Value=[None|Full], Default=[Full]
	Controls access to the "Downloads" button in the Provider Portal. 

	Portal.Referring.OutsidePractice
	Value=[None|Full], Default=[None]
	Controls the ability to default the "Include patients outside my practice" checkbox in the Referring Patient Search screen Full access defaults the checkbox on. 

	Portal.Referring
	Value=[None|Full], Default=[None]
	Controls access to the Provider Portal. 

	Portal.Um.Admin.CacheInfo
	Value=[None|Full], Default=[None]
	Controls access to the Cache Information from UM Admin. 

	Portal.UM.Admin.ConfigAccess
	Value=[None|Full], Default=[None]
	Controls access to the "App Config and Override" screen in the UM Portal. Added in v3.2021.4.12 #29542

	Portal.UM.Admin.TrainingMaterial
	Value=[None|Full], Default=[None]
	Controls access to the "Training Material" tab in the UM Admin Portal. Added in v3.2021.11.22 #30445

	Portal.UM.Admin
	Value=[None|Full], Default=[None]
	Controls access to the UM Portal Administration login. 

	Portal.UM
	Value=[None|Full], Default=[None]
	Controls access to the UM Portal. 

	Portal.UMOpinionLetter
	Value=[None|Full], Default=[None]
	Controls access to the "UM Opinion Letter" tab for viewing documents. (see also: Portal.AuthLetter). 

	PowerScribe360.Enable
	Value=[None|Full], Default=[Full]
	Controls access to the menu item that controls if we send messages to Powerscribe 360 via API integration. 

	Reporting.ExportAudioAndReport
	Value=[None|Full], Default=[None]
	Controls the ability to export the current report audio and text to an external location from the Report Editing window. 

	Reporting.ImportAudioAndReport
	Value=[None|Full], Default=[None]
	Controls the ability to import external report audio and text from the Report Editing window. 

	Reporting.ReleaseOthersTentativeSignedReports
	Value=[None|Full], Default=[None]
	Controls the ability to release a tentatively signed report that was signed by another user. 

	Reporting.SendTo
	Value=[None|Full], Default=[Full]
	Controls access to the "Send To" button from the Reporting screen. 

	Reporting.ShowModelInfoOption
	Value=[None|Full], Default=[None]
	Controls access to the Document Model icon from the Toolstrip. 

	Reporting.UnprotectDataFields
	Value=[None|Full], Default=[None]
	Controls access to the "Unprotect Fields" button from the Reporting screen. 

	ReportingEditor.StedmansDictionary
	Value=[None|Full], Default=[None]
	Controls the ability to use the Stedman's Medical dictionary. 

	RIS.WindowsClient.Login
	Value=[None|Full], Default=[Full]
	Controls access to the RIS Windows Client application. 

	UserPreference.DetailedChairSelector
	Value=[None|Full], Default=[None]
	Controls access to the Detailed Chair Selector in User Preferences. Added in v3.2018.5.6 #21765

	UserPreference.EditorPolling
	Value=[None|Full], Default=[None]
	Controls the ability to use "Editor Polling" option in User Preferences. 

	UserPreference.MaintainFieldBrackets
	Value=[None|Full], Default=[None]
	Controls the ability to use "Maintain Field Brackets" option in User Preferences. 

	UserPreference.PACSServerOverride
	Value=[TBD], Default=[Disabled]
	Controls access to the "PACS Server Override" option in User Preferences. 

	UserPreference.ProxySigning
	Value=[TBD], Default=[Disabled]
	Controls the ability to use "Proxy Signing" option in User Preferences. 

	UserPreference.ReportingAutoSave
	Value=[None|Full], Default=[None]
	Controls access to the "AutoSave" checkbox in User Preferences. 

	UserPreference.TentativeSigning
	Value=[TBD], Default=[Disabled]
	Controls the ability to utilize Tentative Signing. 

	UserPreference.Theme.AllowDarkMode
	Value=[None|Full], Default=[None]
	Controls the ability to turn on Dark Mode theme in User Preferences. 

	UserPreference.Theme.LocalizationHelpers
	Value=[None|Full], Default=[None]
	Controls the ability to enable Localization Helpers in User Preferences. 

	View.AssignTo
	Value=[None|Full], Default=[Full]
	Controls access to the "Notes" menu item from the View menu (visible when the Dictate window is open). 

	View.AttachmentHistory
	Value=[None|Full], Default=[Full]
	Controls access to the "View / Selected Attachments" menu item from Dictation screens. 

	View.Attachments
	Value=[None|Full], Default=[Full]
	Controls access to the "visible when the Dictate window is open)" menu item View menu (visible when the Dictate window is open). 

	View.BreastDrawing
	Value=[None|Full], Default=[Full]
	Controls access to the "Breast Drawing" menu item from the View menu (visible when the Dictate window is open on a Mammo study). 

	View.Custom.Layouts
	Value=[None|Full], Default=[None]
	Controls the ability to customize the reporting layout. 

	View.DetailedSummary
	Value=[None|Full], Default=[Full]
	Controls access to the "Exam Details" menu item from the View menu when the Dictation window is open. 

	View.DigitalFormAnswers
	Value=[None|Full], Default=[Full]
	Controls access to the "Digital Form Answers" menu item from the View menu when the Dictation window is open. 

	View.DrawingHistory
	Value=[None|Full], Default=[None]
	Controls access to the "Drawing History" menu item from the View menu when the Dictation window is open. 

	View.ExamDetails
	Value=[None|Full], Default=[Full]
	Controls access to the "View » Exam Details" menu item from Dictation screens. 

	View.FindingFollowup
	Value=[None|Full], Default=[None]
	Controls access to the "Finding Follow-Up" menu item from the View menu when the Dictation window is open. 

	View.LoadLayout
	Value=[None|Full], Default=[Full]
	Controls access to the "item View / Load Layout (on Dictation screens)" menu item from Dictation screens. 

	View.MacroBrowser
	Value=[None|Full], Default=[Full]
	Controls access to the "menu item View / Macro (on Dictation screens)" menu item from Dictation screens. 

	View.Macros
	Value=[None|Full], Default=[Full]
	Controls access to the "Macro Browser" menu item from the View menu when the Dictation window is open. 

	View.PatientFolder
	Value=[None|Full], Default=[Full]
	Controls access to the "Patient History" menu item from the View menu when the Dictation window is open. 

	View.PatientHistory
	Value=[None|Full], Default=[Full]
	Controls access to the "Main" menu item from Dictation screens. 

	View.Portals
	Value=[None|Full], Default=[None]
	Controls access to the "Main" menu item from Dictation screens. 

	View.Preset.Administration.PresetCriticalResult
	Value=[None|Full], Default=[None]
	Controls access to the Preset Layout Administration for Critical Results. 

	View.Preset.Administration.PresetDictationFull
	Value=[None|Full], Default=[None]
	Controls access to the Preset Layout Administration for Dictation Full. 

	View.Preset.Administration.PresetDictationMinimal
	Value=[None|Full], Default=[None]
	Controls access to the Preset Layout Administration for Dictation Minimal. 

	View.Preset.Administration.PresetDictationNormal
	Value=[None|Full], Default=[None]
	Controls access to the Preset Layout Administration for Dictation Normal. 

	View.Preset.Administration.PresetEditing
	Value=[None|Full], Default=[None]
	Controls access to the Preset Layout Administration for Editing. 

	View.Preset.Administration.PresetPeerReview
	Value=[None|Full], Default=[None]
	Controls access to the Preset Layout Administration for Peer Review. 

	View.Preset.Administration.PresetSigning
	Value=[None|Full], Default=[None]
	Controls access to the Preset Layout Administration for Signing. 

	View.Preset.Administration
	Value=[None|Full], Default=[None]
	Controls access to the "preset layout Administration su" menu item. 

	View.PresetCriticalResult
	Value=[None|Full], Default=[Full]
	Controls access to the "Main" menu item. 

	View.PresetDictationFull
	Value=[None|Full], Default=[Full]
	Controls access to the "Main" menu item from Dictation screens. 

	View.PresetDictationMinimal
	Value=[None|Full], Default=[Full]
	Controls access to the "Main" menu item from Dictation screens. 

	View.PresetDictationNormal
	Value=[None|Full], Default=[Full]
	Controls access to the "Main" menu item from Dictation screens. 

	View.PresetEditing
	Value=[None|Full], Default=[Full]
	Controls access to the "Main" menu item from Dictation screens. 

	View.PresetPeerReview
	Value=[None|Full], Default=[Full]
	Controls access to the "Main" menu item from Dictation screens. 

	View.PresetSigning
	Value=[None|Full], Default=[Full]
	Controls access to the "Main" menu item from Dictation screens. 

	View.PriorReport
	Value=[None|Full], Default=[Full]
	Controls access to the "Main" menu item from Dictation screens. 

	View.Referring
	Value=[None|Full], Default=[None]
	Controls access to the "Referring" menu item from the View menu when the Dictation window is open. 

	View.ReportAssistant
	Value=[None|Full], Default=[None]
	Controls access to the "Main" menu item from Dictation screens. 

	View.ReportFields
	Value=[None|Full], Default=[Full]
	Controls access to the "Main" menu item from Dictation screens. 

	View.Reset
	Value=[None|Full], Default=[Full]
	Controls access to the "Reset Layout" menu item from the View menu when the Dictation window is open. 

	View.Save
	Value=[None|Full], Default=[Full]
	Controls access to the "Save Layout" menu item from the View menu when the Dictation window is open. 

	View.SelectedAttachments
	Value=[None|Full], Default=[Full]
	Controls access to the "Scanned Attachement History" menu item from the View menu when the Dictation window is open. 

	View.SelectedBreastDrawing
	Value=[None|Full], Default=[Full]
	Controls access to the "Selected Breast Drawing" menu item from the View menu when the Dictation window is open. 

	View.SelectedDigitalFormAnswers
	Value=[None|Full], Default=[Full]
	Controls access to the "Selected Digital Form Answers" menu item from the View menu when the Dictation window is open. 

	View.Summary
	Value=[None|Full], Default=[Full]
	Controls access to the "Summary" menu item from the View menu when the Dictation window is open. 

	View.SummaryPrior
	Value=[None|Full], Default=[Full]
	Controls access to the "View » Selected Summary" menu from Dictation screens. 

	View.TemplateBrowser
	Value=[None|Full], Default=[Full]
	Controls access to the "Main" menu item from Dictation screens. 

	View.Templates
	Value=[None|Full], Default=[Full]
	Controls access to the "Template Browser" menu item from the View menu when the Dictation window is open. 

	View.Titlebar
	Value=[None|Full], Default=[Full]
	Controls access to the "View / Show Hide Titlebar" menu item from Dictation screens. 

	WL.Activity
	Value=[None|Full], Default=[None]
	Controls access to the "Activity worklist" menu item from the Administration menu. 

	WL.AppointmentConflict
	Value=[None|Full], Default=[None]
	Controls access to the "appointments with conflicts" worklist. Added in v3.2018.2

	WL.BillingConfirmation
	Value=[None|Full], Default=[None]
	Controls access to the "Billing Confirmation worklist" menu item from the Administration menu. 

	WL.BillingException
	Value=[None|Full], Default=[None]
	Controls access to the "Billing Exception worklist" menu item from the Administration menu. 

	WL.Birads0
	Value=[None|Full], Default=[Full]
	Controls access to the "ACR Category 0 Follow-up worklist" menu item of BI-RADS category 0 items. 

	WL.Birads45
	Value=[None|Full], Default=[Full]
	Controls access to the "ACR Category 4/5 Follow-up worklist" menu item of BI-RADS category 4 or 5 items. 

	WL.BrowseEntireRegion
	Value=[None|Full], Default=[None]
	Controls access to the "Browse Entire Region worklist worklist" menu item. 

	WL.CancelledOrders
	Default=[]
	. Note: Removed and no longer used. 

	WL.ClinicalTask
	Value=[None|Full], Default=[None]
	Controls access to the "Clinical Task" worklist from the Administration menu. Added in v3.2018.2

	WL.ClosedRoomsReschedule
	Value=[None|Full], Default=[None]
	Controls access to the "Rescheduling Studies Affected by Closed Modalities worklist" menu item. 

	WL.Confirmation
	Value=[None|Full], Default=[None]
	Controls access to the "Conformation worklist" menu item from the Scheduling menu. 

	WL.CriticalResults
	Value=[None|Full], Default=[None]
	Controls access to the "CTRM Requests (that are still open) worklist" menu item from the Administration menu. 

	WL.DDHistoryFilteredByDate
	Value=[None|Full], Default=[None]
	Controls access to the "Document History by Date worklist" menu item from the Administration menu. 

	WL.DirectMessage
	Value=[None|Full], Default=[None]
	Controls access to the "Direct Message Inbox worklist" menu item. 

	WL.FailedPACSCorrection
	Value=[None|Full], Default=[None]
	Controls access to the "Failed PACS Correction worklist" menu item from the Administration menu. 

	WL.Folders
	Value=[None|Full], Default=[None]
	Controls access to the "Folders" menu item from the File menu. 

	WL.ImageRequest
	Value=[None|Full], Default=[None]
	Controls access to the "Image Request worklist" menu item from the Administration menu. 

	WL.IVT
	Value=[None|Full], Default=[None]
	Controls access to the "IVT worklist" menu item from the Administration menu. 

	WL.LabWL
	Value=[None|Full], Default=[None]
	Controls access to the "Labwork worklist" menu item. 

	WL.LabworkAdvisedWL
	Value=[None|Full], Default=[None]
	Controls access to the "Labwork Advice" context menu. 

	WL.LabworkRequestedWL
	Value=[None|Full], Default=[None]
	Controls access to the "Labwork Requested" context menu. 

	WL.MammoFollowUpOrders
	Value=[None|Full], Default=[None]
	Controls access to the "Mammo Follow Up Orders worklist" menu item from the Mammo menu. 

	WL.MammoLetters
	Value=[None|Full], Default=[None]
	Controls access to the "Mammo Letters worklist" menu item from the Mammo menu. 

	WL.MT.ActionPending
	Value=[None|Full], Default=[None]
	Controls access to the "Pending Review worklist" menu item from the Editor menu. 

	WL.MT.ActionPendingAll
	Value=[None|Full], Default=[None]
	Controls access to the "Pending Review All worklist (admin)" menu item from the Editor menu. 

	WL.MT.DictatedAll
	Value=[None|Full], Default=[None]
	Controls access to the "Dictated All worklist (admin)" menu item from the Editor menu. 

	WL.MT.EditsPendingQA
	Value=[None|Full], Default=[None]
	Controls access to the "All Edits Pending QA" menu item from the Editor menu. 

	WL.MT.GeneralQueue
	Value=[None|Full], Default=[None]
	Controls access to the "Editor Polling workflow for General Queue" menu item from the Editor menu. 

	WL.MT.GetJob
	Value=[None|Full], Default=[None]
	Controls access to the "Editor Polling workflow for General Queue / all queues" menu item from the Editor menu. 

	WL.MT.PeerReviewPendingActionAll
	Value=[None|Full], Default=[None]
	Controls access to the "All Peer Reviews Pending QA worklist" menu item from the Editor menu. 

	WL.MT.PendingQAAll
	Value=[None|Full], Default=[None]
	Controls access to the "All Pending" menu item from the Editor menu. 

	WL.MT.ProblemQueue
	Value=[None|Full], Default=[None]
	Controls access to the "Editor Polling workflow for Problem Queue" menu item from the Editor menu. 

	WL.MT.QaQueue
	Value=[None|Full], Default=[None]
	Controls access to the "Editor Polling workflow for QA Queue" menu item from the Editor menu. 

	WL.MT.ReportDrafted
	Value=[None|Full], Default=[None]
	Controls access to the "Report Drafted worklists" menu item from the Editor menu. 

	WL.MT.ReportDraftedAll
	Value=[None|Full], Default=[None]
	Controls access to the "Report Drafted All worklist (admin)" menu item from the Editor menu. 

	WL.MT.ReportDraftedProblem
	Value=[None|Full], Default=[None]
	Controls access to the "All Problem worklist" menu item from the Editor menu. 

	WL.MT.ResetOpenSkippedRows
	Value=[None|Full], Default=[None]
	Controls access to the "Reset / Open Skipped Rows menu option" menu item from the Editor menu. 

	WL.MT.SignedPendingQA
	Value=[None|Full], Default=[None]
	Controls access to the "Signed Pending QA worklist" menu item from the Editor menu. 

	WL.MT.Suspended
	Value=[None|Full], Default=[None]
	Controls access to the "Editor Suspended worklist" menu item from the Editor menu. 

	WL.MT.SuspendedAll
	Value=[None|Full], Default=[None]
	Controls access to the "All worklist (admin)" menu item from the Editor menu. 

	WL.NoShow
	Value=[None|Full], Default=[None]
	Controls access to the "No Show worklist" menu item from the Administration menu. 

	WL.PatientFolder
	Value=[None|Full], Default=[Full]
	Controls access to the "Patient Folder worklist" context menu When [Full], context menu item is enabled, otherwise item is hidden. Added in v3.2018.5.6 #22725

	WL.PatientMergeRequest
	Value=[None|Full], Default=[None]
	Controls access to the "Patient Merge Requests worklist" menu item from the Administration menu. 

	WL.PendingBiopsyResult
	Value=[None|Full], Default=[None]
	Controls access to the "Biopsy Result worklists" menu item from the Administration menu. 

	WL.PendingOrders
	Value=[None|Full], Default=[None]
	Controls access to the "Pending Ordersworklist" menu item from the Scheduling menu. 

	WL.PersonMergeRequest
	Value=[None|Full], Default=[None]
	Controls access to the "Person Merge Request worklist" menu item from the Administration menu. 

	WL.Protocol
	Value=[None|Full], Default=[None]
	Controls access to the "Protocol Worklist" menu item on theRadiologist menu. Added in v3.2018.3

	WL.Rad.CriticalResultsAll
	Value=[None|Full], Default=[None]
	Controls access to the "All Currently Open CTRM Requests worklist" menu item. 

	WL.Rad.DictatedAll
	Value=[None|Full], Default=[None]
	Controls access to the "Dictated All worklists (admin)" menu item from the Radiologist menu. 

	WL.Rad.DictatedFilteredByDate
	Value=[None|Full], Default=[None]
	Controls access to the "Dictated by Current User worklists" menu item from the Radiologist menu. 

	WL.Rad.ExamDone
	Value=[None|Full], Default=[None]
	Controls access to the "Pending Dictation worklist" menu item from the Radiologist menu. 

	WL.Rad.ExamDoneAll
	Value=[None|Full], Default=[None]
	Controls access to the "Pending Dictation All worklists (admin)" menu item from the Radiologist menu. 

	WL.Rad.FindingFollowup
	Value=[None|Full], Default=[None]
	Controls access to the "Finding Follow up worklists" menu item from the Radiologist menu. 

	WL.Rad.MyCriticalResults
	Value=[None|Full], Default=[Full]
	Controls access to the "My CTRM Request (requests are still open) worklist" menu item. 

	WL.Rad.MySignedFilteredByDate
	Value=[None|Full], Default=[None]
	Controls access to the "My Signed Filtered by Date worklist" menu item from the Radiologist menu. 

	WL.Rad.PeerReviewPendingActionAll
	Value=[None|Full], Default=[None]
	Controls access to the "All Peer Reviews Pending QA worklist" menu item from the Radiologist menu. 

	WL.Rad.PendingBiopsy
	Value=[None|Full], Default=[None]
	Controls access to the "Pending Biopsy worklists" menu item from the Radiologist menu. 

	WL.Rad.PendingBiopsyAll
	Value=[None|Full], Default=[None]
	Controls access to the "Pending Biopsy All worklists" menu item from the Radiologist menu. 

	WL.Rad.PendingEdit
	Value=[None|Full], Default=[None]
	Controls access to the "Pending Edit worklist" menu item from the Radiologist main menu. 

	WL.Rad.PendingSignature
	Value=[None|Full], Default=[None]
	Controls access to the "Pending Signature worklist" menu item from the Radiologist main menu. 

	WL.Rad.Problem
	Value=[None|Full], Default=[None]
	Controls access to the "Radiologist Problem" worklist menu item. 

	WL.Rad.QA
	Value=[None|Full], Default=[None]
	Controls access to the "Radiologist QA worklist" worklist menu item. 

	WL.Rad.ReportsToPeerReview
	Value=[None|Full], Default=[None]
	Controls access to the "Reports to Peer Review" worklist from the Radiologist menu. 

	WL.Rad.ReportsToPeerReviewAll
	Value=[None|Full], Default=[None]
	Controls access to the "All Reports to Peer Review" worklist from the Radiologist menu. 

	WL.Rad.ResetOpenSkippedRows
	Value=[None|Full], Default=[None]
	Controls access to the "Reset/Open Skipped Rows" menu item from the Radiologist menu. 

	WL.Rad.SignedFilteredByDate
	Value=[None|Full], Default=[None]
	Controls access to the "Signed by Date worklist" menu item. 

	WL.Rad.SupervisingDictation
	Value=[None|Full], Default=[None]
	Controls access to the "Supervising Dictation worklist" menu item from the Radiologist menu. 

	WL.Rad.Suspended
	Value=[None|Full], Default=[None]
	Controls access to the "Suspended worklist" menu item from the Radiologist menu. 

	WL.Rad.SuspendedAll
	Value=[None|Full], Default=[None]
	Controls access to the "Suspended All worklist (admin)" menu item from the Radiologist menu. 

	WL.Rad.TentativelySigned
	Value=[None|Full], Default=[None]
	Controls access to the "All Problem worklist" menu item from the Radiologist main menu. 

	WL.Rad.TentativelySignedAll
	Value=[None|Full], Default=[None]
	Controls access to the "Tentatively Signed Reports All worklist" menu item from the Radiologist menu. 

	WL.Rad.TranscribedAll
	Value=[None|Full], Default=[None]
	Controls access to the "Pending Signature All worklists (admin)" menu item from the Radiologist menu. 

	WL.Reception
	Value=[None|Full], Default=[Full]
	Controls access to the "Reception worklist" menu item from the Front Desk menu. 

	WL.ScheduledFilteredByDate
	Value=[None|Full], Default=[None]
	Controls access to the "Scheduled worklist" menu item. 

	WL.TechFilteredByDate
	Value=[None|Full], Default=[Full]
	Controls access to the "Tech Filtered Date worklist" menu item. 

	WL.UnknownReconciliation
	Value=[None|Full], Default=[None]
	Controls access to the "Unknown Referring & Carrier worklist" menu item. 

	WL.UnknownReferring
	Default=[]
	. Note: Removed and no longer used. 

	WL.UseMaterializedWorklistPattern
	Value=[None|Full], Default=[None]
	Enables the "Materialized Worklist " pattern that provides advanced worklist functionality. Added in v3.2018.2

	WL.UtilizationManagement
	Value=[None|Full], Default=[None]
	Controls access to the "Utilization Management worklist" menu item from the Administration menu. 

	WorklistViews.Group.Edit
	Value=[None|Full], Default=[None]
	Controls access to the "Create / Edit / Delete" commands from the Worklist Group View. 

	WorklistViews.User.Edit
	Value=[None|Full], Default=[Full]
	Controls access to the "create / edit / delete" commands from the Worklist User View. 

	Zotec.AddMedicalRecordPayment
	Value=[None|Full], Default=[Full]
	Controls access to the "Add Medial Record Payment" menu item from the Front Desk main menu that is used to add a medical record payment. Updated by #15223

	Zotec.AllowDiscount
	Value=[None|Full], Default=[None]
	Controls the ability to discount procedures from the Zotec time-of-service website. 

	Zotec.AllowRefund
	Value=[None|Full], Default=[None]
	Controls the ability to give refunds from the Zotec time-of-service website. 
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Alert AgeGreaterThan Value={None{Full, Default={Full - Displays the *Age Greater Than alert type when [Ful. 1 Ful 10.22.202001:3
Alert Both TechOniyAndExternalReport Value=[None[Full], Defaut=[Full] - Displays the "Bot Tech Only and External Report*alertty... 1 Ful 10222020013
Alert CDS_01_High' ValueNone[Full, Default=Full - Displays the “High BP" alert type when [Fulll 1 Ful 10.22.202001:3
Alert CDS_02_HighCholesteral Value<{None[Full, Default=[Full- Displays the “High Cholesterol"alerttype when [Full. 1 Ful 10.22.202001:3
Alert CDS_03,_PossibleReaction Value={None{Full, Default=[Full - Displays the Possible Reaction” alerttype when [Ful. 1 Ful 10.22.202001:3
Alert CDS_04_TobaccoUser Value=fNonelFull], Default={Ful] - Displays the Tobacco User” alerttype when [Full. 1 Ful 10.22.202001:3
Alert CDS_05_PneumoniaBooster Value={None{Full, Default={Full - Displays the ‘Pneumonia Booster”alerttype when [Ful. 1 Ful 10.22.202001:3
Alert CDS_06,_BreastCancerSereening Value=[None[Full], Default=[Ful - Displays the ‘Breast Cancer Screening alerttype when [F.. 1 Ful 10222020013
Alert Expiredinsurance Value={None{Full, Default={Full - Displays the "Expired Insurance alerttype when [Full. 1 Ful 10.22.202001:3
Alert HasAllergy Value={None[Full, Default=[Full - Displays the"Has Allergy” alert type when [Fulll. 1 Ful 10.22.202001:3
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